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Editorial In this November issue 
of 2DArtist Magazine we go atmosphere 
crazy with a fantastic steampunk tutorial 
by Ioan Dumitrescu, who shows us how 
to use Google SketchUp to create a 3D 
base to get some interesting structures 
established for a 2D illustration 
(paintover) in Photoshop, and we have 
Darren Yeow showing us how to make 
custom brushes for clouds – perfect 
for adding some extra oomph to our 
environments and giving rockets a good 

kick off the Earth! These two tutorials illustrate just how a bit of extra 
attention to creating atmosphere in your paintings can go a long way to 
improving the overall quality of your artwork. So follow Ioan and Darren on 
p.52 and p.40, and see what their techniques can do for you!

We have a character-filled tutorial on p.62 for you this month, as our 
Dynamic Characters series draws to a close. David Smit speaks openly 
and honestly about his theory of good camera placement, framing, and 
fore-shortening in digital painting. Confidently accepting this tutorial for 
2DArtist, David soon realized what a huge subject he’d let himself in for, 
and the result of this is a fun article filled with genuine discussion about 
what works, what doesn’t, and where you should pay close attention 
and further develop your understanding of the subject. This is a really 
enjoyable article for those who are brushing up their skills and want to 
further their knowledge on the topic of camera placement and framing, to 
give their character illustrations that extra bite! And stay tuned to 2DArtist 
as we’ll be interviewing David Smit in the next issue.

Nykolai Aleksander brings us the penultimate chapter in our Beginner’s 
Guide to Digital Painting tutorial series this month (p.78), looking at using 
photos to give texture to your paintings, and discussing various selection 
techniques which are handy when it comes to incorporating photos in your 
work – be it photo manipulation or matte painting. With the tutorial now 
in its final stages, Nykolai will be back next month to wrap up the series 
and will bring us her final version of the painting, complete with finishing 
touches and tweaks, as well as some lessons on how to save our work for 
various uses. 

In the spirit of Halloween last month we featured a zombie-inspired 
illustration by James Wolfe Strehle … This month, he’s back and he’s 
brought the zombies with him! We asked James to write a making of 
article for this issue, discussing the creation of his nightmarish image, 
painted in Photoshop. Feeling rather hungry at the time he was putting 
the article together for us, he has taken a unique approach to his making 
of – one which I’ve never come across before – and takes us through the 
painting process using the analogy of … a sandwich! I’ll leave you on your 
seat edge there and let you read the article for yourself to find out what I 
mean – it’s a really quirky article that I’m sure you’ll love, so hop on over to 
p90 to find out more.

Our Sketchbook article takes a step away from the usual pencil grays of 
our past issues this month, as Lois van Baarle shows us how she uses 
blocks of color to sketch her ideas down and warm up for her paintings. 
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This is a beautiful and colorful article with some behind-the-scenes notes 
touching on a variety of sketching styles and techniques, so please 
stop by p.16 to enjoy Lois’s sketchbook, and be sure to check out her 
“sketchblog” (http://sketchblog.loish.net) for more from this talented artist!

To wrap up this issue, we interview Feng Zhu on p.6 – who needs no 
introduction! As director of his own company and school, we were simply 
privileged that he could spare us some precious moments to talk to 
2DArtist about his latest endeavors. We have a stunning selection of his 
work published in his interview article to accompany the fantastic answers 
to our probing questions. And talking of great artwork, stop by the Gallery 
on p.30 to see new work by Arnaud Valette, Jason Seiler, and George 
Patsouras before you get back to your digital canvases and paint those 
evenings away. Enjoy this issue, and we’ll see you back here for another 
next month! Ed.

http://www.2dartistmag.com
http://sketchblog.loish.net
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Setting up your PDF reader 
For optimum viewing of the magazine it is recommended that you have 

the latest Acrobat Reader installed.  

You can download it for free here:  DOWNLOAD!   

To view the many double-page spreads featured in 2DArtist magazine, 

you can set the reader to display ‘two-up’, which will show double-

page spreads as one large landscape image: 

   

1. Open the magazine in Reader;   

2. Go to the View menu, then Page display; 

3. Select Two-up Continuous, making sure that Show Cover 
Page is also selected.

Get the most out of your 

Magazine!
If you’re having problems viewing the double-page spreads that we 

feature in this magazine, follow this handy little guide on how to set 

up your PDF reader!

http://www.adobe.com/products/acrobat/readstep2.html
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Ioan 
Dumitrescu 
20 year old architecture 

student and self-taught concept 

designer. He loves drawing the 

things he imagines in his head, 

and trying to convey a story to the viewer through 

them. He is currently working freelance.

 

jononespo@yahoo.com

Contributors

Contributing Artists
Every month many artists around the world contribute to 3DCreative and 

2DArtist magazines. Here you can find out more about them. If you would 

like to be a part of 3DCreative or 2DArtist magazine, please contact: 

lynette@3dtotal.com

Nykolai  
Aleksander

Born in Germany in 1978, she 

moved to England in 1999, 

and currently lives in South 

Africa with her husband. She’s 

been painting digitally since 2002, and works as 

a freelance illustrator for both private clients and 

companies.

 

 

 

http://www.admemento.com 

x@admemento.com

Darren
Yeow
27-year old self-taught 

illustrator, originally hailing 

from Adelaide, has worked as 

a concept artist, user interface 

designer and art director in video game companies 

for the past four years, and currently lives in 

Melbourne. Outside his full-time role as an in-house 

concept artist working on next-gen games, he tutors 

hopeful young artists, works on commissioned 

freelance projects, and is writing a book for those 

wishing to pursue a career in concept art.

�http://stylusmonkey.carbonmade.com

David  
Smit

When not traveling or working 

overseas, David resides in 

Amsterdam, freelancing in 

concept art, illustration and art 

direction jobs. It’s only when he sleeps that he’s not 

busy! He is always on the search for great projects, 

opportunities, stories, good music, and a nice cold 

beer. 

http://www.davidsmit.com 

david@davidsmit.com

James  
Wolf Strehle 
A passionate freelance il-

lustrator working in New York 

who spends 100% of his time 

painting – 70% learning and 

30% making fun of animals. He claims to be terrible 

at math, he has a beard to keep his hair in place, and 

he’s always looking for new work and opportunities 

to pursue. If you would like to learn more about this 

odd fellow, you can do so through his website and 

blog.

http://jameswolfart.blogspot.com/

www.jamiestrehle.com
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mailto:jononespo@yahoo.com
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http://www.admemento.com
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Vancouver Film School alumni credits include Across the Universe Geeta Basantani, Digital 
Compositor Astro Boy Andreas Hikel, Layout Artist Avatar Michael Cozens, Lead Animator 
Tamir Diab, Technical Director | Aaron Gilman, Animator | Alfredo Luzardo, Layout Technical 
Director Babel Luis Blackaller, Storyboard Artist | Lon Molnar, Visual Effects Supervisor Battlestar 
Galactica Daniel Osaki, Lead Modeler | Megan Majewski, 3D Animator | Alec McClymont, 3D Artist 
Bioshock 2 (VG) Jacob Palmer, Animator Bolt Lino Di Salvo, Supervising Animator/Voice of Vinnie 

Charlotte’s Web Aruna Inversin, Digital Compositor | Adam Yaniv, Character Animator | Tony 
Etienne, Lead Lighter | Kristin Sedore, Lighter The Chronicles of Narnia: Prince Caspian Andreas 

Hikel, Pre-Visualization Artist | Christoph Schinko, Character Animator | Jami Gigot, Senior Layout 
Artist Cloverfield Nicholas Markel, Pre-Visualization Supervisor Constantine Aruna Inversin, Digital 

Compositor Coraline Brian Demoskoff, Animator The Dark Knight Pietro Ponti, Lead CG Lighting Artist 
Diablo III Alvaro Buendia, Cinematic Artist | Steven Chen, Cinematic Artist District 9 Neill Blomkamp, 

Director | Shawn Walsh, Visual Effects Executive Producer | Jelmer Boskma, Modeler | Bernhard Kimbacher, 
Visual Effects Data Coordinator & Compositor | Julianna Kolakis, Creature Texture Painter | Adam Marisett, 

Visual Effects Artist | James McPhail, Visual Effects Technical 
Director | Dominic Cheung, Lighting Technical Director | Grant 
Wilson, Animator | Joey Wilson, Modeler Drag Me to Hell Thomas 
Schelesny, Visual Effects Supervisor Dragon Age: Origins (VG) Herbert Lowis, Character Artist | Bobby Bath, 

Character Artist | Ryan Lim, Character Artist Family Guy Michael Loya, Storyboard Artist Fantastic Four: Rise 
of the Silver Surfer Arun Ram-Mohan, Lighting Technical Director | Shawn Walsh, Visual Effects Executive 
Producer | Jessica Alcorn, Compositor The Final Destination Grant Wilson, Animator | David Yabu, Animator 

Fringe Scott Dewis, CGI Supervisor Gears of War (VG) Scott Dossett, Animator G.I. Joe: The Rise of Cobra 
Allen Tracy, Visual Effects Editorial Supervisor | Aruna Inversin, Digital Compositor | Jeremy  Stewart, Senior 

Animator | Jelmer Boskma, Modeler The Golden Compass Adam Yaniv, Animator | Chad Moffitt, Animator | Thom 
Roberts, Animator | Ben Sanders, Animator | Andrew Lawson, Animator | Matthias Lowry, Visual Effects | Tony 

Etienne, Look Development | Justin  Hammond,  Lighter | Pearl Hsu, Effects Technical Director | Aruna Inversin, Digital 
Compositor | Fion Mok, Matchmove Artist Hairspray Lon Molnar, Visual Effects Production Executive Halo 3 (VG) Bartek 

Kujbida, Character Animator Happy Feet Ben Sanders, Character Animator | Thom Roberts, Character Animator Harry 
Potter and the Half-Blood Prince Harry Mukhopadhyay, Lead Effects Technical Director | Gia Sadhwani, Digital Effects 

Artist | Pietro Ponti, TD Generalist | Teh-Wei Yeh, Lighting TD Hellboy II: The Golden Army Christoph Ammann, 3D Sequence 
Supervisor Horton Hears a Who Arun Ram-Mohan, Lighting Technical Director | Brent Wong, Modeler Ice Age: Dawn of the 

Dinosaurs Scott Lemmer, Animator | Thom Roberts, Animator | Brent Wong, Modeler I, Robot Daniel Osaki, CGI Modeler | Megan 
Majewski, Pre-Visualization The Incredible Hulk Shawn Walsh, Visual Effects Executive Producer | Tony Etienne, Look 
Development Lead The Incredibles Daniel Holland, Animator Indiana Jones and the Kingdom of the Crystal Skull Henri Tan, 

Creature Technical Director Iron Man Adam Marisett, Visual Effects Artist King Kong Chad Moffitt, Senior Animator King of 
the Hill Michael Loya, Director Kingdom of Heaven Shawn Walsh, Digital Compositor Left 4 Dead (VG) Nick Maggiore, 

Animator Letters from Iwo Jima Aruna Inversin, Digital Compositor Live Free or Die Hard Jessica Alcorn, Compositor 
Lord of the Rings Trilogy Chad Moffitt, Senior Animator Lost Scott Dewis, Visual Effects Artist The Lovely Bones 
Michael Cozens, Previs Animator Mass Effect (VG) Sung-Hun (Ryan) Lim, 3D Modeler Matrix: Revolutions Aruna 
Inversin, Digital Compositor | Shawn Walsh, Color & Lighting Technical Director Master & Commander: The Far Side 
of the World Robert Bourgeault, CG Artist Metal Gear Solid 4 (VG) Josh Herrig, Artist | Yuta Shimizu, Artist The 
Mummy: Tomb of the Dragon Emperor Aruna Inversin, Digital Compositor Persepolis Marianne Lebel, Animator 
Pirates of the Caribbean: At World’s End Ben Sanders, Character Animator | Allen Holbrook, Animator | Aruna 
Inversin, Digital Compositor Resident Evil: Extinction Joshua Herrig, Visual Effects Artist Robots Arun Ram-Mohan, 
Additional Lighting Rome Teh-Wei Yeh, Matchmove Artist Scarface (VG) Maya Zuckerman, Mocap 3D Generalist 
Shrek the Third Rani Naamani, Animator Shrek the Third (VG) Samuel Tung, Technical Artist Sin City Michael Cozens, 
Lead Animator Smallville Geeta Basantani, Lead Compositor SpongeBob SquarePants Andrew Overtoom, Animation 
Director Star Trek Aruna Inversin, Digital Compositor | Tom Piedmont, Digital Plate Restoration Star Wars Episode 
III: Revenge of the Sith Andrew Doucette, Character Animator |  Nicholas Markel, Pre-Visualization Star Wars: 

Knights of the Old Republic (VG) Arun Ram-Mohan, 3D Artist | Jessica Mih, Level Artist Stargate: Atlantis Daniel 
Osaki, 3D Animator | Megan Majewski, 3D Animator | Alec McClymont, 3D Artist Sweeney Todd: The Demon 

Barber of Fleet Street Jami Gigot, Concept Artist Terminator Salvation Teh-wei Yeh, Lighting Technical 
Director | Geeta Basantani, Digital Matte Painter Transformers: Revenge of the Fallen Bryan Jones, 
Compositor | Aruna Inversin, Digital Compositor | Henri Tan, Creature Technical Director | Teh-wei Yeh, 

Digital Artist | Stephen King, Animator Twilight Geoffrey Hancock, Digital Effects Supervisor Uncharted 2: 
Among Thieves (VG) Mike Yosh, Lead Animator Unreal Tournament III (VG) Scott Dossett, Artist Up Bill Watral, 

Visual Effects Artist WALL-E  Mark Shirra, Layout Artist | Bill Watral, Effects Artist | Daniel Holland, Production Artist 
Watchmen Lon Molnar, Visual Effects Supervisor | Sean Lewkiw, Technical Head of 3D | Dominic Cheung, 3D Artist | Ty 

Duperron, Previs Artist | Pearl Hsu, 3D Artist | Matthias Lowry, Digital Compositor | Ori Ben-Shabat, Compositor | Shawn 
Walsh, Visual Effects Supervisor Where the Wild Things Are Justine Codron, Lighting TD World of Warcraft: Burning 
Crusade (VG) Carman Cheung, Animator Warhammer 40,000: Dawn of War II (VG) Ian Cumming, Senior Artist | Nathan 
Hocken, Lead Animator Zombieland Mike Rhone, Visual Effects Artist 2012 Christine Peterson, Digital Compositor 

Anuj Patil, Senior Technical Director | Jamie Bowers, Texture Artist 9 Mike Dharney, Animator and many more.
VFS student work by Thiago Martins

Your name here.

http://vfs.com/animationvfx


Feng is a guy that needs very little introduction. He’s one of the most influential artist around to 

date. He’s worked for the likes of Lucas Arts and Blur Studios, and he’s contributed his talents 

to countless high profile movies. Currently the director of his own design company and also his 

new school, we chat with this extremely busy artist in our latest 2DArtist interview.

“When I first got a call from 
the ranch, it was definitely 
quite - what’s the best way to 
put it? - exciting, I guess. To 
be able to work in the place 
where all the films I love had 
been created...”
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Feng Zhu Interview

Interview with Feng Zhu
Hi Feng, it’s a real pleasure chatting with 

you today. Being an artist who needs little 

introduction we will skip the normal opener 

and plum for a more unique starting question: 

Could you describe what fascinates you about 

drawing, what the lure is?

I think for me it’s more about the design versus 

the drawing. Because for me, where the 

fascination comes from is creating something 

that never existed before. To always see that 

design come out in either the form of a video 

game, film or toy, that’s the part that pays off. 

Guess that’s what makes me happy when 

that stuff comes out. As for the drawing part, 

I don’t care too much about it as I was never 

really an artist. When I was growing up, I was 

always thinking about new designs and how to 

get all these ideas in my head out onto paper. 

So drawing, for me, is actually just a tool or I 

guess a communication method. I really wasn’t 

involved in colours or different type of stylings 

and rendering techniques so I really cannot get 

my designs to come out there. The fact that 

somebody else or a team can make it into a 

project or product, that’s the fascination for me. 

What first drew you to art and what schools/

colleges did you attend, to develop your skill? 

What got me started in this is, again, design. I 

actually went into architecture originally because 

I didn’t know about the whole entertainment 

design industry. Actually at that time, which was 

about the mid-nineties, there wasn’t a big push 

in that field. Right now it is very popular to have 

all those “behind the scenes”, “art of ...” features 

and concept art on DVDs and almost all major 

films now offer them. But back then, there were 

only VHS tapes and no “behind the scenes” 

features. It was very hard for someone like 

myself to find out how to get into the industry 

and so I chose the closest thing: architecture 

at UC Berkeley. I went there for about a year 

and I found out that architecture was really 

different from what I wanted to do. At that point, 

I started asking my friends how I get into the 

entertainment industry or the games industry as 

an entertainment designer. That’s when I found 

out about CalArts and Art Center. I went to visit 

both schools and just by looking at the students’ 

gallery I immediately knew that Art Center was 

http://www.2dartistmag.com
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the school to attend. They were doing stuff way 

ahead of the industry. Most of their projects 

took place in either weird, really strange worlds 

or very much in the future. So I dropped out of 

Berkeley and went straight to Art Center and I 

never looked back. It was a really cool place. 

Looking over your bio on your website you’ve 

definitely had a career that any up-and-coming 

artist would dream of. Not only have you worked 

for some of the top games companies around, 

you’ve also had the opportunity to work with the 

man that bought Star Wars to life. What was it 

like working for Mr Lucas and what was your 

role in the production of Episode III?

Well, it was fun and I think like any job, the 

first two weeks were partially professional and 

partially filled with fan boy moments. These 

IPs we touch existed even when I was a kid. I 

grew up, of course, watching Star Wars and I’d 

always wanted to work on a film like that. When 

http://www.2dartistmag.com


page 9www.2dartistmag.com Issue 047 November 2009

Feng Zhu Interview

I first got a call from the ranch, it was definitely 

quite - what’s the best way to put it? - exciting, 

I guess. To be able to work in the place where 

all the films I love had been created, like Indiana 

Jones etc ... 

The first week there was very magical. George 

has this Skywalker Ranch in the middle of pretty 

much nowhere. It’s a very nice, huge Victorian 

house; there’s no work environment like that 

in all the film industry. And all the original stuff 

from Star Wars and Indiana Jones and other IPs 

are still in the house. So you are surrounded by 

“George has this Skywalker 
Ranch in the middle of pretty 

much nowhere. It’s a very 
nice, huge Victorian house; 

there’s no work environment 
like that in all the film 

industry.”

http://www.2dartistmag.com
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a lot of history, history that molded my career. 

It’s definitely an experience that is very hard to 

explain unless you have been there. 

And then, of course, there was meeting Mr 

George Lucas. I was kind of nervous, I guess, 

for the first week or two because normally it’s 

hard for anyone to meet George and there 

he was, working one on one with us in these 

meetings. But then after a two to three week 

period, everything settled down and everyone 

turned professional. It was just another job, to 

make the movie happen and make the clients - 

in this case, George - happy. So we just worked 

week by week, designing things we needed for 

the film.

The other part that I really liked about working 

at the ranch were all my friends. Most of them 

were people I went to school with at Art Center. 

So it was kind of like a class reunion of some 

sorts. Everyone was working in the same place, 

a very small art department with about six 

people. We had a lot of fun times there since 

the work was quite hard. So we were there for 

http://www.2dartistmag.com
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many late nights, pulling all-nighters and doing 

all these things. But yeah, it was lots of fun! 

Your portfolio has to be one of the most 

interesting that I’ve seen; I could have spent 

hours flicking through your work. Your concepts 

for EA’s Battle for Middle Earth II game are 

truly inspirational. The one piece that brings a 

smile to my face is the little Tutenstein character 

you’ve done. Could you tell us a bit about this 

character and how he came about?

Wow, Tutenstein! That was back when I worked 

at Blur Studios. So Blur is one of those houses 

that take on many different kinds of projects at 

once. Often we worked on something we called 

bid projects, which is when the studios have 

a script idea but don’t know what it is going to 

look like. Until they do, it is very hard to get that 

project made. So they go to a studio like Blur to 

visualize the concept and the first person that 

this kind of job lands on is the concept guy. 

For the Tutenstein project I read the pitch and 

it was about a little kid that had died a long 

time ago in Egypt and who is being shown in 

http://www.2dartistmag.com
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a museum. Somehow at night, he wakes up 

and he’s got little cat with him, and they control 

everything in the museum. It sounded like a very 

cool idea for a kids’ show and reminded me a 

little bit of Calvin and Hobbes, because Calvin 

also has a cat or tiger and they do imaginary 

friends stuff. So I liked that because Calvin and 

the Hobbes is my favourite comic. 

The original concept for this project was actually 

going to be in 3D, I believe, but the real show 

ended up being done in flash or 2D. When I 

designed it, I added a lot of details to make sure 

that it was very iconic and would appeal to kids. 

But there was also a bit of evilness in there for 

the older generation. It was quite fun, but I think 

the final product strayed a little bit away from the 

original idea, mostly, I believe, due to budget. 

But still, it was very cool and I was glad to be a 

part of it. 

So what’s the standard process for you when 

you come to do a concept? Do you start off 

traditionally then move to the computer or do 

you hit the Wacom first?

I guess it’s both. When I started from about ‘97 

all the way to 2003, I was working traditionally, 

meaning I was drawing on paper and finishing 

stuff on paper. But in about June or July of 

2003, I made the decision to completely switch 

over to digital. This was mainly for efficiency 

reasons because in our industry, the saying 

that “time is money” is very, very true. If you 

can deliver something fast that also looks good 

then you can make more income that way. 

Working on a computer increases your speed 

tremendously because you have things like the 

ability to texture, to undo and all these brushes 

so you don’t have to carry around equipment. 

It was very hard at first, but after about 

three months I felt like paper was no longer 

necessary. So I actually haven’t drawn a single 

thing on paper for professional reasons since, 

I guess, ‘03. For the past six years, it has been 

all digital and everything, including the rough 

thumbnails, has been done on a Wacom. 

That’s the beauty of digital art. It’s something 

I call the “first generation pass”, which means 

a thumbnail to a rough to a final image can 

actually take place in the exact same drawing. 

You can start something very rough, clean it up 

“If you can deliver something 
fast that also looks good then 
you can make more income 

that way.”

http://www.2dartistmag.com
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a little bit, paint on it and turn into a painting, 

all from the initial sketch. Whereas when using 

traditional methods that cannot happen because 

we do a little tiny thumbnail, then blow it up 

and do a photocopy, and it becomes second 

generation. And then if you overlay it or copy it, 

that becomes third generation. Rendering on top 

of that copy becomes fourth generation already. 

So by the time you get to the fifth or sixth 

generation, you’ve actually lost quite a bit of the 

energy that the designer put in.

I like the computer because it makes the works 

feel more alive. You can feel the personality of 

the designer inside the piece and that’s how I 

like to work these days. As far as how I do the 

design, there’s no difference. Every designer, 

I believe, does the same thing. You start by 

brainstorming on paper, producing a bunch of 

thumbnails, getting the ideas out and trying to 

find as many interesting shapes as possible. 

Being an entertainment designer, the number 

one thing I have to focus on is that it has to be 

very cool. Things like functionality and all that 

stuff still have to be taken into consideration, 

but because my stuff doesn’t have to exist in 

the real world, I have the luxury of being able to 

focus on making it look cool. 

Teaching is a big part of your life right now with 

you setting up a design school, but how did 

this all start? What is it about teaching that has 

made you devote so much of your time to it?

Well, it’s true - right now I devote about half 

of my time to teaching. This actually started a 

while ago, just in L.A. I was asked by a school 

to be a kind of TA; to substitute for a teacher. 

I’d never taught prior to that. I showed up and 

the cool thing is that all the students in my 

class at that school were professionals. I had 

professional comic book guys and professional 

film guys and all these really, really talented 

people and that really changed my concept of 

teaching. Especially that class, because a lot 

of those guys actually became my friends and 

we were able to share ideas and help each 

other produce better work. And I saw the direct 

translation of my teaching into the projects they 

were working on. For example, I have a couple 

of guys who were taking my class to learn how 

to do concepts for designing the Matrix film. 

Afterwards, they showed me how the work they 

“I was like, ‘Wow, all the 
stuff I have been teaching 

them is going into these huge 
films!’ ”

http://www.2dartistmag.com
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were doing for the film and I was like, “Wow, all 

the stuff I have been teaching them is going into 

these huge films!” It was pretty interesting. 

After that, I taught at Gnomon for a long time. 

And then Art Center finally invited me to teach 

over there and that was a huge honour for me 

because they take their staff very seriously. All 

their teachers are very high caliber; it’s almost 

like getting a job at a very high-end studio. So 

the fact that they asked me to teach not only 

their regular class, but their very, very advanced 

entertainment courses, was quite a real honour. 

I have been addicted to teaching ever since 

because you see a lot of people. When they 

are in school, they are called students but 

when they get out, they become your peers. 

They become the people you sit next to, the 

people you work on projects with and you 

help each other find jobs. So by teaching, 

you’re essentially building your own network 

of designers. A lot of these guys will stick very 

close to you because often times, you helped 

them find their first job or helped them get into 

the industry - I have lots of stories like that. It’s 

always great for me when someone has taken 

one of my classes in a subject they didn’t know 

much about before and then after a few years, 

they are out there making all these cool projects 

and cool video games I am playing. Like when 

you see the credits at the end of a video game 

and you are like, “Wow, that was a student of 

mine” or “I remember teaching that guy this 

thing and now he’s doing this thing” - that’s a 

great feeling.

It’s all about sharing as many things as possible. 

That’s what makes our school quite different. 

We give out everything we know. If I find some 

new technique or something for Photoshop, we’ll 

teach it right away. We don’t follow any kind of 

curriculum in that sense, like you have to teach 

this, that and this. We cover the fundamentals 

and anything else that is going to help the 

students get a job or advance their careers. We 

definitely don’t hold back any kinds of  secrets. 

You’ve got your design studio, your new school 

... so what’s the next mile stone for you?

For me, right now, I think getting the school up 

and running is definitely the highest priority. The 

next is trying to develop some new IPs because 

in the past, I worked on a lot, I guess, but they 

all belonged to somebody else. I think it’s the 

dream of every designer to start doing stuff for 

themselves. But I also know the reality of things, 

which is that creating new IPs is very difficult 

to do from scratch. If you are a designer, there 

are thousands and thousands of IPs out there. 

They are all pretty cool, but how many of them 

actually make it somewhere? So knowing that 

reality and with my experience from running the 

games company, I’ve partnered up with some 

key people to help bring everything together. 

We’ll be announcing how we’re actually going 

to do that a couple of months from now. 

Basically, the partnership enables myself and 

my partner to take IPs and realize them much 

more effectively than just having pieces of 

paper covered in concepts. So that’s what I am 

working on next and hopefully it will make a big 

splash next year, at somewhere like E3 and 

Comic Con or something like that. 

Alright, that’s it. Thanks guys and talk to you 

again soon!

Feng Zhu
For more work by this artist please visit:

http://www.fengzhudesign.com

http://www.fzdschool.com

Interviewed by: Christopher Perrins

http://www.2dartistmag.com
http://www.fengzhudesign.com
http://www.fzdschool.com
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This month we delve into the sketchbook of digital illustrator and painter 
Lois Van Baarle.

“Working with 
blocks of color 
helps me to 
get this kind of 
thing out of my 
system quickly 
whilst retaining 
the gesture and 
personality in 
it that I wanted 
to achieve 
initially.”
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Sketchbook of 
Lois van Baarle

City
I drew these sketches as a warming up exercise 

to start the day – at the time I was making an 

animated short, so I had to get ready for lots of 

drawing each morning (Fig.01). The sketches 

include a number of caricatures of some people 

who live in my neighborhood in Utrecht. I drew 

them in Photoshop after discovering a more chalky 

kind of brush, which inspired me to draw using 

blocks of color rather than lines. This helped me 

to experiment with shapes and forms more than 

I would usually. Although the final result is not 

exactly detailed, it’s a really great way to make 

quick character sketches!

Dogs
Again, I used the same tools as with City to create 

these images, trying to capture the different 

personalities of each dog using primarily shapes 

and color (Fig.02). I was also trying to think like an 

animator, using simple forms and minimal detail 

that could be translated into animated characters if 

need be.

http://www.2dartistmag.com
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No Girl
This is a rough sketch that never made it 

into anything, not even a post in my sketch 

blog (Fig.03). I abandoned it because I 

felt like the colors weren’t working out. In 

this image you can see the techniques 

that I usually use when sketching digitally 

in Photoshop: painting over a darker 

background (I started with a maroon base 

layer which you can see through the blue 

background in some areas), using the Warp 

tool to get the figure looking just right, and 

using very rough brushstrokes before going 

into more detail.

Bubblegum
This is a rough sketch I did which ended 

up being the starting point for a finished 

digital painting (Fig.04a – b). In this case, 

I sketched using lines instead of blocks 

of color or rough brushstrokes. In the 

sketch you can see two layers of sketched 

lines – the lighter red lines which form the 

original sketch, and the darker lines which 

I sketched on top of the original. When 

sketching with lines, I tend to start really 

rough and work my way towards a more 

detailed sketch using many different layers. 

It would probably be less time-consuming to 

just finish the sketch in one go, but I prefer 

to work towards detail gradually.

http://www.2dartistmag.com




Red
This is a very quick sketch – it 

probably took me about five minutes 

to do – which I did purely out of the 

motivation to draw something red 

(Fig.05). Working with blocks of 

color helps me to get this kind of 

thing out of my system quickly whilst 

retaining the gesture and personality 

in it that I wanted to achieve initially. 

The style also appeals to me – 

sometimes more detail does not 

make a better image!
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City II
These are a number of sketches I made in my sketchbook while sitting at 

a cafe in the city, in front of a large square (Fig.06). Since people walked 

past very quickly I had to draw them as quickly as I could, and usually 

didn’t spend more than a few seconds on each one. After drawing a 

number of characters with a thin felt-tipped pen, I colored the negative 

space black with ink to emphasize the shapes and postures of the 

different people, helping to bring out their personalities. Sketching like this 

helps me to learn how to draw faster and to try and capture the essence of 

what I’m seeing, rather than all the details.

http://www.2dartistmag.com
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Girl Sketches
This is a collection of sketches from my 

sketchbook, drawn over a longer period of time 

(Fig.07). My sketchbook is a combination of 

drawings from life as well as drawings from my 

imagination – these are from the latter. Most 

of them are just mindless doodles done for fun 

or initial concepts for digital paintings I end up 

finishing later. The tools I like to use for this 

are thicker, rougher paper and mechanical 

pencils – by far my favorite kind of pencil to 

draw with.

http://www.2dartistmag.com


Teacher
This is a sketch that I did as part of a sketching 

challenge on a forum (Fig.08). Sometimes, 

when I’m out of ideas, I end up browsing the 

web in search of ideas, and forums such as 

these are a great solution. In this case, people 

were asked to sketch an image of a teacher 

in 30 minutes. For this image I worked with 

Photoshop and applied my usual technique 

of working with shapes and blocks of color, 

but ended up going into more detail. I had my 

physics teacher from seventh grade in mind 

while drawing it.





Tanzania
These are a number of sketches from the 

sketchbook I had with me while in Tanzania 

(Fig.09). I was there for two months and 

attended the Bagamoyo Arts Festival, in which 

tribes from all over the country travelled to the 

festival in order to perform. When traveling, 

keeping a sketchbook with me is really important 

because, in a way, it captures more than what 

photos can. In the future, I would also like 

to travel and then publish the sketchbooks I 

create while traveling – something I discovered 

I wanted to do because of how I sketched in 

Tanzania.



Wilders
This is a caricature of the 

Dutch politician, Geert Wilders 

(Fig.10). I really enjoy doing 

caricatures, and it’s 

especially interesting 

when drawing one 

from a photograph 

since there are 

so many details 

that can be 

incorporated into 

the drawing. In 

this picture I 

wanted to capture 

Wilders’ bitter 

expression and 

make his head 

especially large – 

a symbol I found 

fitting for this man’s 

personality!

Lois van Baarle
For more information please visit:

http://loish.net/

Or contact:

loishh@gmail.com

http://loish.net/
mailto:oishh@gmail.com
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This Month we Feature:

George Patsouras & Abbas Saleem Khan 

Steven DiNozzi

James Wolf Strehle

Joe Slucher

Duc. Truong Huyen

 Arnaud Valette

Pavel Cucka 

Stephen Molyneaux

Jason Seiler

Alex Andreyev
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The Lost World
Pavel Cucka

http://www.pavelcucka.com

pavel@pavelcucka.com

(Below)

Burnette
Stephen Molyneaux

http://www.old-boy.co.uk

stevemolyneaux@hotmail.com

(Right)

http://www.2dartistmag.com
mailto:gallery@zoopublishing.com
http://www.pavelcucka.com
mailto:pavel@pavelcucka.com
http://www.old-boy.co.uk
mailto:stevemolyneaux@hotmail.com
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Female Dwarf
Joe Slucher

http://joeslucher.daportfolio.com/

slucherj@yahoo.com

(Right)

The Resurrectionist
George Patsouras & Abbas Saleem Khan

http://cgaddict.blogspot.com/

http://www.bakatron.com/ 

cgaddict@live.com

(Below)

http://www.2dartistmag.com
mailto:gallery@zoopublishing.com
http://joeslucher.daportfolio.com/
mailto:slucherj@yahoo.com
http://cgaddict.blogspot.com/
http://www.bakatron.com/
mailto:cgaddict@live.com


Slumscraper
Duc. Truong Huyen

http://fxevo.cgsociety.org/gallery/

truong.huyenduc@gmail.com

http://fxevo.cgsociety.org/gallery/
mailto:ruong.huyenduc@gmail.com


Bad side of the city
James Wolf Strehle

http://jamiestrehle.com/

jameswolfstrehle@yahoo.com

http://jamiestrehle.com/
mailto:jameswolfstrehle@yahoo.com
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Vertigo
Steven DiNozzi (CGTantra Username: sdinozzi) 

http://www.stevedinozzi.com

steve@stevedinozzi.com

(Above) 

Winner of the CGTantra August 2009 Matte Painting Challenge, 

sponsored by 2DArtist Magazine

The White Star
Arnaud Valette

http://www.arnaudvalette.com

arnovalette@gmail.com

(Below)

http://www.2dartistmag.com
mailto:gallery@zoopublishing.com
http://www.stevedinozzi.com
mailto:steve@stevedinozzi.com
http://www.arnaudvalette.com
mailto:arnovalette@gmail.com
http://www.cgtantra.com/
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Alex Andreyev

http://www.behance.net/alexandreev 

http://alexandreev.com

andreevbox@gmail.com

http://www.2dartistmag.com
mailto:gallery@zoopublishing.com
http://www.behance.net/alexandreev
http://alexandreev.com
mailto:andreevbox@gmail.com
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Village Voice
Jason Seiler

http://www.jasonseiler.com 

jseiler@jpusa.org

http://www.2dartistmag.com
mailto:gallery@zoopublishing.com
http://www.jasonseiler.com
mailto:jseiler@jpusa.org
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This tutorial series will revolve around the use of 3d as a starting point for digital painting. In particular we will 

explore the value of Google SketchUp, a free program enabling users to quickly build 3d environments using 

a set of intuitive tools.

This technique is used by many contemporary artists and is used as a quick and effective way of establishing 

correct perspective as well as offering a moveable camera in order to experiment with compositions.

As a 3d package SketchUp is easy to learn and does not require hours of training and as an artist wishing 

to draw complicated scenes, this approach can prove a valuable starting point for producing a template on 

which to paint over.

“I love scattering human 
figures around an image: 
doing the dirty jobs like 
cleaning pipes or the furnace 
of a locomotive, or perhaps 
directing passengers into a 
building.”

• Free Base Image

http://www.2dartistmag.com/tutorial_resources/issue_047_nov_2009/tutorial01/tutorial01_free_baseimage.zip
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Using Google SketchUp as 
a base for Digital Painting

Why use SketchUp?
Google SketchUp is a free programme enabling 

users to quickly and effectively build 3D 

environments using a number of intuitive tools. 

Unlike most 3D packages it is very easy to learn 

and does not require hours of training before 

decent results are achievable. It is very versatile 

and with regards to digital painting can prove an 

invaluable tool in swiftly establishing a correct 

perspective, as well as offering a moveable 

camera in order to experiment with alternative 

viewpoints and compositions. 

An object can be made and then duplicated 

any number of times, so if a structural element 

is repeated throughout your concept then this 

package can quickly and accurately create 

such arrays. It also has a simple-to-use lighting 

system that enables placement of the sun 

according to the month and time of day by 

way of slider bars, thus determining physically 

correct shadows that can be turned on or off at 

the click of a button. These functions mean that 

as an artist wishing to draw detailed or tricky 

scenes, one can use SketchUp as a valuable 

starting point to establish a “guide template” on 

which to paint over.

Installation
In order to install SketchUp, click on the link 

below and go to Downloads on the left hand 

menu. Select the free version which is currently 

version 7 (Fig.01). Choose your operating 

system and then follow the instructions. 

http://sketchup.google.com/

Once installed, click on the application shortcut 

and you will be prompted with the following 

dialogue box in which you are asked to choose 

a template (Fig.02). The scale and type of your 

scene will determine which you choose, but 

for the purposes of this tutorial we will select 

Architectural Design – Feet and Inches.

Toolbars and Menus
When SketchUp starts you will see a screen 

resembling Fig.03. From the main menu click 

on View > Toolbars > Large Tool Set; this will 

access more tools which will appear down the 

left margin. To change the display mode of the 

objects in the scene click on View > Face Style; 

this will show a number of options, as seen in 

Fig.04.

If you also check Views under View > Toolbars 

you will see six small house icons appear 

below your toolbar (Fig.05). These will provide 

quick access to orthographic views, as well 

as isometric. You will notice that I have also 

checked Face Style in the list (highlighted in 

green), which has added some cube icons to 

represent the display modes. 

This is basically where you can customise your 

workspace and add toolsets to speed up your 

workflow. For additional help go to Window > 

Instructor; this will open a window providing 

useful information on whichever tool you have 

currently selected.

http://www.2dartistmag.com
http://sketchup.google.com/
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Basic Navigation
The key orientation tools you will use to navigate 

in your scene are Orbit, Pan and Zoom, which 

you will find on the top toolbar and whose 

shortcut keys are represented by O (Orbit), 

H (Pan) and Z (zoom). These can be seen in 

Fig.06.

The main tools used to directly manipulate your 

objects are Move (M), Rotate (Q) and Scale (S). 

The Scale tool appears on the left hand toolbar 

which you will see highlighted if you press S on 

your keyboard.

Drawing Shapes
One way of using SketchUp is to create two-

dimensional shapes from which you can extrude 

three-dimensional objects. Select the top view 

and then the Line tool (Fig.07) and left-click in 

the viewport to begin drawing. You will notice 

that as you do so, the points will snap to the 

green and red axes, thus easily enabling the 

creation of right-angled structures.

When you finally close the shape by clicking on 

the initial point you will notice the shape turns 

blue, indicating a surface has been made; once 

a shape has become closed you can still edit 

it, however. Using the Line tool, add an internal 

rectangle (see top diagram in Fig.08). To now 

make this edge become part of the exterior 

shape click on the Eraser tool and then on the 

outside edge shown in red.

You can continue to cut into your shape or 

alternatively extend it outwards and then erase 

the necessary lines by using the Line tool 

(Fig.09). Here I have added a walkway and 

also a curved section using the Arc tool. You 

can also draw more organic shapes using the 

Freehand tool (Fig.10).

One other useful function, especially for 

architectural structures, is the Offset tool which 

is situated next to the Rotate tool. This enables 

a shape to be duplicated in order to create 

depth – perfect for drawing walls in a building, 

for example (Fig.11).

With an exterior wall depth, click on the large 

internal shape using the Select tool (black arrow 

on Toolbar) and hit delete. You can then select 

the Push/Pull tool and then click on the wall and 

raise it vertically (Fig.12). You will notice I have 

edited the section where the walkway adjoins 

http://www.2dartistmag.com


page 43www.2dartistmag.com Issue 047 November 2009

Using 3D as a Base for 2D Painting Part 5: 

is above the Fog label, and to get more control 

over this function go to View > Toolbars > 

Shadows. This will place two slider bars on your 

toolbar which denote the month and time of day. 

By adjusting these you can control the position 

of the sun and direction of the shadows (Fig.16). 

There is a little icon to switch the lighting on or 

off, and besides this there is also another icon 

which opens up some extra parameters that 

alter the tonal range of the shading. You can 

the building using the Line and Eraser tools so 

that this was not raised along with the outer wall.

Three Dimensions
When a shape has been converted into 3D it 

can be edited further by using a combination 

of the Line and Push/Pull tools. If you move 

the Line tool along an edge it will snap to the 

midpoint between opposing edges (Fig.13). You 

can then make equally spaced cuts, as shown. 

These new shapes can be pushed inward or 

pulled outward, or alternatively a new shape can 

be drawn and this can then be manipulated.

In Fig.14 I have used the Offset tool to create 

a window shape in the far left rectangle. To 

create the same proportioned window in the 

other sections simply select the Offset tool 

and double-click in each rectangle. To create 

the arches use the Arc tool and then erase 

the horizontal join shown by the dotted line. 

To create windows use the Push/Pull tool to 

move the shapes inwards beyond the inner wall 

surface or until they disappear. 

Using a combination of the tools mentioned 

so far you will have the means through which 

to create and edit a wide range of forms and 

design detailed scenes.

Atmospherics & Lighting
You can add atmospheric perspective in the 

form of fog to your scene. Go to View and check 

Fog, as seen in Fig.15. You will notice that the 

edges on my building have also been switched 

off, which you can control in the menu under 

Edge Style > Display Edges.

To add lighting effects check Shadows which also control whether this affects just the object 

itself or the ground along with it and vice versa.

Additional Tools
A few other useful tools worth mentioning are 

the Tape Measure, Protractor and Dimension. 

The Tape Measure is used to draw guidelines 

which can then be traced over with the Line tool. 

In Fig.17 you can see that the tape measure 

has created the dotted lines which can be 

http://www.2dartistmag.com
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used as a guide to draw the windows an equal 

distance from the top and bottom of the block. 

To delete the lines simply use the Eraser tool.

The Protractor is used to create accurate 

angles. Move the tool to the point at which you 

wish to start the angle and you will see how it 

snaps to the three axes. Click to establish the 

correct plane and then click to begin the angle 

along the appropriate edge. Now you can set 

the angle using the guideline. In Fig.18 I have 

used the near corner as the starting point, which 

I will mirror on the opposite corner.

Once the guidelines are drawn, trace them 

using the Line tool, as with the Tape Measure. 

In Fig.19 you can see that the two angles have 

been drawn and then the Push/Pull tool was 

used to extrude a roof shape across the base 

block.

The Dimension tool simply adds a label to 

your scene, showing the distance between two 

points. Click and drag from A to B and then drag 

up or down to set your dimensions, once again 

using the Eraser tool to delete when necessary 

(Fig.20).

Cameras
The camera in SketchUp is initially placed at an 

average eye level height, so for example when 

you click on the Position Camera tool it will 

zoom in and appear around head height from 

the ground. In this sense scale is an important 

factor in your scene. 

In Fig.21 you can see a cross where I intend to 

position the camera, after which the viewpoint 

will resemble the inset image. The character has 

been placed in the scene to demonstrate the 

relationship between the scale of a character 

and the initial camera height. To adjust your 

camera, use the Look Around tool represented 

by the eye icon.

One final tool which may prove useful is the 

Section Plane tool which allows a view of a 

cross-section of your object. To use this click 

on the tool and then align the green icon to the 

corresponding plane or angle you wish to view. 

Then select the Move tool and click on one 

of the corner arrows and drag in the relevant 

direction (Fig.22).

This concludes our overview which I hope has 

at least introduced the main tools and their 

functions. There are of course further lessons 

to learn along with other tools and techniques, 

such as applying materials, but the main aim 

here is to introduce the interface and value of 

the software in terms of building a simple 3D 

environment which can then be used in digital 

painting.  

Richard Tilbury
For more from this artist visit:

http://www.richardtilburyart.com/

Or contact them at:

rich@3dtotal.com

http://www.2dartistmag.com
http://www.richardtilburyart.com
mailto:rich@3dtotal.com
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one. I can then create the intersections, which 

I imagine to look like strong beams which the 

locomotives might use to get across to the other 

side. 

I use the Rectangle tool and start making lapped 

boxes which I will then extrude with the Push 

tool. After making one section of the beam, I 

multiply it and move it on the first mirrored deck. 

I then make double pillars with a diagonal metal 

element for the structure above, in-between 

them, so that I can give my future painting 

a believable, industrial look. Other diagonal 

beams coming from these pillars will sustain the 

bridged sections. All shapes are created with the 

Rectangle tool or the Line tool, which can create 

planes and volumes if used in three-dimension.

On the left side I want to mirror the diagonal 

feeling from the right side, so I firstly make some 

pillars, and then create walls for each pair of 

pillars (Fig.02). I play around a bit here with the 

silhouette of the structure, just to spice things up 

a little. When happy, I go on to create a series 

of open and closed spaces between each wall, 

for the locomotives, people, and cargo to all 

pass through – all done using the Rectangle 

tool. I also create a low ceiling above each of 

the passageways and close the middle part of 

the three sections of the wall. On the right part 

I pull the pillars up to the next floor and add 

decks for potential people passing through. I 

also make some intersecting platforms between 

the left and right structures whilst thinking about 

accommodating possible functions within a train 

depot. 

To finish off the 3D part of the work in Google 

SketchUp, I make sure I enable the three-

colored Axes under the View menu, select Face 

Style > Monochrome, and go to the Window 

menu where I select Styles > Default Styles 

> Engineering Style. For the Camera setup I 

choose Perspective from the drop-down menu. 

I then rotate the scene, searching for some 

cool viewpoints. When ready I can then export 

my chosen view by going to File > Export > 2D 

Graphic (Fig.03). 

The cool thing about this 3D scene is that you 

I can always go back and add new levels or 

find new points of view if I want to make some 

Using 3D as a base for 2D 
Painting
Software Used: Google SketchUp and 

Photoshop

Introduction
It’s always a good idea when creating concept 

art or illustrations for games, movies and the 

like, to use whatever means and methods 

necessary to make your artwork quickly and 

easily. In the case of this tutorial I will be using 

a simple 3D base which I’ll create in Google 

SketchUp as a mockup for a Photoshop 

painting.

Google SketchUp
I start with a simple idea in the back of my 

mind of a sort of train depot where locomotives 

are traveling in and out, loading cargo, and 

transporting people. So to get things moving, 

in Google SketchUp I begin by building some 

simple platforms as a starting point (Fig.01). I 

choose a simple profile shape and then extrude 

it outwards. I copy the profile section and mirror 

it so that it’s not too far away from the first 
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Overlay and Color layers (Fig.05).

From this point on I start to define the arches 

and pillars. For contrast I use a white wood 

material for the pillars and arches on the right-

hand side, with a green metal to achieve a more 

industrial, steampunk look to them (Fig.06). 

Right now I’m pretty sure of where I’m heading 

with this image, so I bring in a couple of textures 

now for the huge stone pillars on the left and 

for the locomotive in the foreground. I make a 

few Levels and Color Balance tweaks to get 

them into place, and then start painting on top 

of them. It’s good to have as much texture as 

possible from the start which matches the kind 

of look you want, just to give you a good base 

to build upon. It’s also important to decide on 

your lighting scheme from the start, too. I want 

a dramatic sunset lighting scenario, coming 

in from the left of the scene, to get that gold, 

steampunk feeling across. I knew from the 

beginning that this kind of lighting would define 

the space better between the pillars and give 

some interesting shadows that fall upon the 

bottom deck and on the locomotives.

I keep refining the shapes on the right-hand side 

and bring in some of the white from the left-hand 

side just to encourage the eye to travel from one 

changes! For a more detailed introduction to 

building structures in Google SketchUp, please 

refer to the first part of this tutorial where 

Richard Tilbury takes you through the basics.

I export about 10 scenes from Google SketchUp 

so I can choose my favorite from those. I decide 

on a somewhat central perspective for its 

balance, strong diagonal line and perspective, 

and good focus (Fig.03). You can download this 

scene with 

Photoshop 
I take the Google SketchUp scene into 

Photoshop now where I can start sketching on 

top of it, on a new layer, to try out some ideas 

(Fig.04). While I was making the 3D image I 

was already thinking about locomotives, metal 

arches, cables, glass facades and so on, so 

here I can start to build these ideas on top of the 

3D render. I also decide to widen the frame to 

give the scene the more cinematic look that I’m 

feeling for this image.

I never repeat the same process in my images, 

and it was no different for this image. I start 

out in black and white to establish my general 

values, and then add color to the image with 

to the other. The space at the top of the image 

is a little disturbing for me though as it’s allowing 

the eye to slip from the frame, so I’m going to go 

with a classic steampunk/industrial theme here 

and add a glass and metal rooftop to my station 

scene. To do this I paint lots of straight lines on 

a separate layer and then simply put them in the 

correct perspective. To stop the eye getting tired 

from all those lines, I add some colored patches 

of glass for contrast and interest (Fig.07).

Remember to flip your image from time to 

time to help you spot mistakes or disturbing 

areas. People often make fun of me, saying, 

“You rotated it again!” But that’s just because, 

composition-wise, I only decide just before the 

final save as to which way it looks best. 

I add some balconies between the pillars to 

give it a more familiar look and to add some 

depth. This also makes the viewer wonder about 

what actually happens there; whether there are 

offices or just passageways up there. 

The next step is to finish the background (which 

is bugging me). I decide to go for look similar 

to old train stations and create a huge, intricate 

façade of metal and glass, which fills a great 

space within the frame (Fig.08).
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away from the dullness it was currently in 

before, before going on and adding the final 

details and making everything more cohesive 

(Fig.09).

It’s not our prerogative to stick to the 3D image 

that we started with, which is the beauty of 

experimentation. I haven’t followed the original 

base scene with the pillars on the right; now, 

between two stone pillars stand some kind of 

hangars – or perhaps they’re just spaces for 

cargo to be deposited and such? Between 

those and the pillar are passages for people to 

pass through. The pillars where a little too plain 

and so I add some sort of engraved pattern to 

them to further define them. I also paint some 

graphics on the cargo bay areas between the 

pillars to help them “pop out” more (Fig.10).

To give some atmosphere to the image, I do this 

at about halfway through the painting process – 

any earlier and it would have distracted me, and 

I wouldn’t want to leave it any later just in case it 

doesn’t fit as well as I imagine it to.

With all these steam-driven machines it was 

easy to add atmosphere into the scene. It also 

helps with the depth and the overall way in 

which the image is read. To add smoke and 

steam, I usually use a standard soft brush with 

texture applied, or alternatively the Chalk brush. 

Generally in my artwork, I use a round brush, 

the Chalk brush and a soft brush, alongside a 

few texture brushes which I’ve collected over 

the years. 

Those huge wheels attached to the locomotives 

which are pulling the locomotives along those 

cables (think in terms of cable cars) were 

under-detailed. So to bring them up to par with 

the scene, I paint them in whilst thinking of the 

mechanics of a clock or watch. I found using a 

Dodge layer very useful to get some stronger 

highlights on the metal and in highlighted areas.

For the interior of the arched structure I’ve 

already decided on a glass roof and walls, so 

I paint those in, keeping in mind the saturation 

levels and making sure everything is nice and 

atmospheric. This helps to punch the image 

Because of the lighting scheme I am able to 

show where the locomotives are going to pass 

between the pillars and out of the depot; this 

gives more functionality to the space.

I love scattering human figures around an 

image: doing the dirty jobs like cleaning pipes or 

the furnace of a locomotive, or perhaps directing 

passengers into a building; maybe they’re just 

standing around chatting or laughing about 

something we have no idea about … They are 

also great for giving scale to a scene. When 

people look at an image they will look for human 

figures to give them a sense of scale of the 

space. 

With a few more smoke trails and steam, some 

light fixtures on the front of the locomotives, and 

some more detail on the foreground decks – all 

those rivets, slabs, stains, etc. – the image can 

be called “done” (Fig.11 – Final). 

I hope I have been able to get the main ideas 

behind this image across to you, as well as the 

techniques involved, and that it will all be useful 

for your own art creation in the future. Thanks 

for reading! 

Ioan Dumitrescu 
aka ‘Jonone’
For more from this artist contact them at:

jononespo@yahoo.com
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“...the main focus of this 
tutorial is to make the 
creation of these airborne 
particles easier, and yet still 
deliver a high quality of 
work. We will accomplish this 
through automation, in the 
form of custom brushes ...“

An artist’s brushes have always been a vital part of any painter’s set of tools, and remain the 

single asset that links paint with canvas. As such, they are crucial to how we view and interpret 

an artwork, and they afford the artist with a means through which to convey an idea or feeling. 

This has always been true throughout the history of art, and is no less important within a digital 

context. Software such as Photoshop and Painter essentially combine and fuse paint, canvas 

and brushes into a single tool. However, within this complex set of “tools”, brushes retain certain 

autonomy with their own, distinct set of parameters and presets, offering artists the freedom to 

affect and vary the way paint is applied. This principle of customizing brushes forms the focus of 

this set of tutorials, and aims to show how individual artists exploit these techniques to achieve 

some interesting results!

- Free Brushes
- Free PSD showing brush
creation process in layers

http://www.2dartistmag.com/tutorial_resources/issue_047_nov_2009/tutorial02/tutorial02_cloud_brushes.zip
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Custom Brushes - Cloud 
Brushes 
Software Used: Photoshop

Introduction
Designing, rendering and ultimately realizing 

an environment or dramatic backdrop is a very 

different undertaking from that of creating a 

character, despite many of the technical and 

observational skills being pretty much the same. 

One of the major differences is the creation of 

atmosphere in an environment. This can be 

achieved through numerous means, such as 

the design of the environment’s elements, the 

type of lighting used to illuminate the scene, and 

other phenomena that comes somewhere in 

between. One of these “in between” elements is 

a collective group I like to think of as “persistent 

airborne particles”; things like smoke, fog, mist, 

cloud and smog. This group is incredibly varied 

and very useful in the composition of the image. 

They help to lead the eye, subvert high density 

detail to a lesser importance and reduce visual 

confusion, and when applied appropriately 

they can dramatically change the mood of an 

environment. Some very powerful uses, I’m sure 

you’d agree!

If you have ever rendered any member of this 

group by hand, you will know that it can be a 

very time-consuming undertaking. There so 

many tiny details and so much randomness that 

it can take a long time to accomplish painting 

these manually, and when the clock is ticking, 

spending too long on any one area of an image 

is a recipe for stress, stretched deadlines, lots 

of teeth grinding, not to mention a plummeting 

reputation! 

Sounds rather dire, doesn’t it? But fear not! With 

this in mind, the main focus of this tutorial is to 

make the creation of these airborne particles 

easier, and yet still deliver a high quality of work. 

We will accomplish this through automation, in 

the form of custom brushes, showing you the 

step-by-step nature of creating a base brush 

image to work with, altering brush settings to 

expedite the creation of these elements, and 

then giving a couple of step-by-step examples of 

how to use these brushes which you can follow 

along with to grow your skills and confidence.

So with all that out of the way, let’s get started!

Before you get started…
If you know me, or have read any of my prior 

tutorials, then you’ll know what I am going to 

begin with: Do your research! Whether you 

know or understand the subject matter intimately 

or not, you need to fill your consciousness with 

new information on a consistent basis in order to 

provide fresh ideas/reminders for your images, 

or you’ll risk growing stale and end up creating 

highly derivative art!

What does this mean in a practical sense? Well, 

in today’s age of blogs, online articles, image 

archives, forums and the like, this essentially 

means jumping on the internet and using your 

favorite search engine to source out some 

visuals to kick start your engine. Some of my 

favorites are listed below – it certainly isn’t 

exhaustive, but these are typically all I need to 

find good references:

http://www.google.com

http://www.ConceptArt.org

http://www.flickr.com

3DTotal has also launched a new free texture 

and reference library which you may find useful 

for your practice – it’s filled with royalty free 

images that you can use in, or as inspiration for, 

your artwork: http://freetextures.3dtotal.com/

If you don’t have the internet then it means a 

little more leg work: going to your local library; 

picking up a newspaper, magazine, trade 

journal; or watching a movie and stock piling 

your mental arsenal from there. Whichever 

resources you choose to draw upon, just make 

sure you use it as inspiration only and don’t 

plagiarize work! That would be unscrupulous 

and doesn’t help your skills level to grow; it will 

more likely lower your confidence in your own 

abilities above all else.

Clouds, Fog and Mist
So we begin with clouds, fog and mist, which 

are naturally occurring phenomena in the 

atmosphere that happen as a result of water 

particles being frozen and suspended in the 

atmosphere. It’s important to keep this in mind 

when you’re rendering any of these, as it affects 

the way light reacts when it comes in contact 

with clouds, fog or mist.

For artistic purposes there is little practical 

difference between each: clouds are moisture 

particles that are suspended in the air above 

ground; fog is cloud that is in contact with the 

ground; and mist is a less dense form of fog. 

Yes, you can get very technical with types of 
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cloud formation and whatnot, but for general 

art creation I tend to run with the mindset of 

whatever compliments the image in order to 

help reach the outcome I am aiming for.

Cloud brushes of this kind can also be used for 

the creation of smoke resulting from fire and 

explosions, so they are very flexible and multi-

purposeful brushes. Let’s make one!

Brush Creation

Step 1: Create a new square ratio canvas in 

Photoshop. I like to create a fairly large canvas 

then downsize it later on so that more details 

are captured in the brush. The image in this 

case is about 700 by 700 pixels. Once you have 

your canvas, using a Soft Round Brush start by 

creating a circular area of tone. This is to set 

the background of a fairly low contrast brush 

(Fig.01).

Step 2: Within the tone, start creating some 

rough cloud particles. Keep the edges irregular 

and accentuate them with some rim lighting 

(Fig.02).

Step 3: Create some tone which splays 

outwards from the epicenter; this will be used 

to give cloud formations some degree of high 

density information in their outer extremities. 

This information will be used to also give scale 

to the large masses (Fig.03).

Step 4: Using a more grayish tone now, reduce 

the overall contrast by brushing a few wide 

strokes over the information, and knocking back 

the details (Fig.04).

Step 5: Work more cloud detail back into the 

image using a darker tone. It isn’t a huge issue 

if it is all rendered to perfection or not; when 

the brush image is reduced in dimension, it will 

become much crisper and the imperfections will 

add to the charm of the image (Fig.05).

Step 6: Ctrl-I to invert the image to check 

for tone that is bleeding to the canvas edge 

(Fig.06).

Step 7: Use a black brush to paint it out any 

white/gray that has bled into the canvas edge 

(Fig.07).

Step 8: Invert the canvas again. This image will 

serve as the basis for the cloud brush (Fig.08).

Step 9: Resize the image down to a more 

appropriate size so as to not take up too much 

precious memory. In this case, I’ve reduced the 

image to around 140 by 140 pixels, because 

in some cases I will need to use the brush at 

a relatively large size. Once you’re happy with 

the size, define the brush preset through Edit > 

Define Brush Preset > Name Your Brush > OK 

(Fig.09).

Step 10: Make sure you have the Brush Tool 

selected (if not press B) and now access the 

brush attributes window through Windows > 

Brushes (or press F5) (Fig.10).
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Step 11: Tick the Shape Dynamic checkbox 

and access those attributes. Alter the Size Jitter 

to 12% to provide some random sizing to the 

cloud elements. Set the Control option to Pen 

Pressure and specify the minimum Diameter as 

55%. Change the Angle Jitter Control option to 

Direction (Fig.11).

Step 12: Tick the Scattering checkbox, make 

sure Both Axes is checked, and alter the 

percentage to 13%. Increase Count to 1 and 

set the Count Jitter to 24%. This Control is to 

provide more built-in random placement of cloud 

particles (Fig.12).

Step 13: Tick the Other Dynamics checkbox. 

Set the Opacity Jitter to 12% and change the 

Control option to Pen Pressure for Flow Jitter 

(Fig.13).

Step 14: Test out your brush. There are lots 

of different types of strokes you can do with 

it. We’ll now go through a worked example to 

see how you would use the brush in a typical 

scenario (Fig.14).

Step-by-Step Example

Step 1: Using the cloud brush we have just 

created, start roughing in the shape of the cloud 

you want. I typically start off with a middle tone 

so that it doesn’t overpower the image and it’s 

equally easy to pull into the dark and the light 

areas (Fig.15).

Step 2: Work the silhouette a little more, adding 

in more detail (Fig.16).

Step 3: Begin to add form by casting lighting 

onto the clouds (Fig.17).

Step 4: More of the same: add light to form and 

push the dark areas into darker tone (Fig.18).

Step 5: More pushing and pulling: light areas 

lighter; dark areas darker; silhouette more 

defined, making sure not to over-render the 

outline of the clouds and keeping a lot of it soft 

like cotton wool (Fig.19).

Step 6: Push back some parts of the image that 

stick out, add a cast shadow, and then darken 

some of the underside form into shadow as it 

receives the least light (Fig.20).
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Step 7: Alter the Brightness/Contrast and tweak 

the Levels, and we’re done! Our first cloud is 

finished, using our newly created cloud brush 

exclusively (Fig.21).

Contrails and Directional 
Smoke
Another type of airborne particle is directional 

smoke or cloud, which has an originating source 

that is dynamic, such as a missile or meteor. 

Contrails are condensation trails of aircraft and 

the same brushes can effectively be used for 

portraying this. The main difference between 

these types of brushes and the regular cloud 

brushes is that these generally need to be 

directional, so the information plotted by the 

brush alludes to direction. This will become 

clearer as we work through the brush creation 

process.

Brush Creation

Step 1: Create a new square ratio canvas in 

Photoshop, and then, using a Soft Round Brush, 

start by creating some large arcs. These are 

essentially the smallest components of a contrail 

or directional smoke. All arcs should face the 

same direction as this is will be important later 

on (Fig.22).

Step 2: Add more tone to give the arcs volume 

and shape. Think of them as balls that are 

placed behind each other, and assume a light 

source coming from the front and below the 

image plane to help you render the image. Don’t 

be too worried about where the image sits right 

now as you’ll eventually crop it later on (Fig.23).

Step 3: Using the Soft Round brush, feather 

over the extremities of the black strokes to blend 

it a little more into the background. This will 

help reduce any harsh lines due to black tonal 

bleeding to the edge of the canvas (Fig.24).

Step 4: Increase the contrast slightly (Fig.25).

Step 5: Ctrl-I to invert the image to check for 

tone that is bleeding to the canvas edge. If there 

is any, use a black brush to paint it out (Fig.26).

Step 6: Invert the canvas again; this will be the 

basis of our smoke trails (Fig.27).

Step 7: Resize the image down to a more 

appropriate size so as to not take up too much 

precious memory. In this case I’ve reduced 

the image to 98 by 98 pixels, because in 

some cases I will need to use the brush at a 

relatively large size. Once you’re happy with 

the size, define the brush preset through Edit > 

Define Brush Preset > Name Your Brush > OK 

(Fig.28).

Step 8: Make sure you have the Brush Tool 

selected (if not press B) then access the brush 

attributes window through Windows > Brushes 

(or press F5) > Brush Tip Shape. Alter the 

Spacing to 35% as it is not essential for a 

continuous flow and speeds up the brush action 

(Fig.29).

Step 9: Alter the Angle of the brush to -94°. This 

is important as the brush is a directional one, 
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place a cast shadow underneath the blast area 

(Fig.35).

Step 2: Using a slightly darker tone, paint 

in more details and reduce the white areas 

between the particles. Make sure to give some 

non-uniform wisps of smoke to make it look 

more natural (Fig.36).

Step 3: Alter the Brightness/Contrast to darken 

the smoke (Fig.37).

Step 4: Using a Soft Round Brush, color-pick 

the darker tone and lightly brush over the image 

to unify the tonal range (Fig.38).

Step 5: Alter the Brightness/Contrast once more 

to bring out the dark smoke, and we’re done! 

This is just a simple example of how to use your 

new directional smoke brush (Fig.39).

Hopefully you’ve enjoyed my little tutorial and 

picked up one or two pointers. To finish up, here 

is an illustration which shows our new brushes 

in use to add some cloud and smoke to set the 

scene being portrayed (Fig.40). 

Thanks for reading! If you have any questions or 

comments, please feel free to contact me. Until 

next time, keep painting!

meaning that as you create a stroke the brush 

will constantly align to whichever direction your 

stylus is travelling (Fig.30).

Step 10: Tick the Shape Dynamic checkbox 

and access those attributes. Alter the Size Jitter 

to 56% to provide some random sizing to the 

smoke trail. Change the Angle Jitter to 5% and 

set Direction as the Control option (Fig.31).

Step 11: Tick the Scattering checkbox. Make 

sure Both Axes is checked and alter the 

percentage to 56%. Increase the Count to 2 

and set the Count Jitter to 24%. This Control is 

to provide more built-in random placement of 

smoke particles (Fig.32).

Step 12: Tick the Other Dynamics checkbox. 

Set the Opacity Jitter to 84% and alter the 

Control option to Pen Pressure for both Opacity 

and Flow Jitter (Fig.33).

Step 13: Test out your brush! As you can see 

again, there are lots of different types of strokes 

you make do with it. We’ll go through another 

worked example now to show you how you can 

use the brush in a typical scenario (Fig.34).

Step-by-Step Example

Step 1: Using our newly created directional 

smoke brush and a light tone, brush in some 

exhaust smoke around the base of the launch 

area, and some additional smoke to allude to 

the dust and smoke being kicked up. If you 

want to ground the smoke, make sure you also 
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Darren Yeow
For more from this artist visit:

http://stylusmonkey.carbonmade.com 

Or contact them at:

darren@stylus-monkey.com

- Free Brushes
- Free PSD showing brush
creation process in layers
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This series of tutorials aims to show some of the methods and processes used to design and develop characters 

from initial thumbnail sketches through to a final concept. The series will be divided into five parts and will focus on 

the general design methods commonly used by character artists. It will begin with quick sketching techniques used to 

suggest ideas and develop a theme before moving onto creating variations once a subject is established. The third 

instalment will culminate in a finished concept design, after which we will move onto the importance of posing your 

character and the impact this has on their personality. The series will conclude with a chapter dedicated to choosing 

suitable eye levels and camera views to best convey an emotional state or emphasise a storyline.

Chapter 1 | Thumbs & Silhouettes

Chapter 2 | Visual Brainstorming – Variations on a Theme

Chapter 3 | Speed Painting & Concept Design

Chapter 4 | Dynamic And Exaggerated Poses 

Chapter 5 | Camera Placement, Framing, Fore-shortening & Distortion

The concluding chapter will deal with the notion of framing and the viewer’s eye level to 

emphasize the intent behind a character and how such devices can allude to the storyline. 

Themes such as fore-shortening, lighting and perspective are all key issues that are 

discussed and the bearing these have on the way we interpret characters in context.

“I have to cut the whole thing down a bit 
in order for me to finish this tutorial before 

I’m 80, so... I’m going to focus on story 
driven composition with a special focus on 

camera placement and framing for dynamic 
characters.”
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Part 5 Camera Placement, 
Framing, Fore-shortening 
& Distortion
A perfect character design – a brilliant idea, just 

brilliant! If people could see this you would be 

the God of all forums, an instant 5-star wonder! 

You’ve worked for weeks on your character; 

every detail fits perfectly and you know exactly 

what kind of environment to put your character 

in. All that remains is to make the final shot, 

after days (and days) of hard labor, getting 

everything exactly right. You – you hero, you! – 

have just created a masterpiece! You upload it 

to the forums … Here you go: you’re on the fast 

track to fame now. You refresh your browser … 

and again. No replies yet. Ah, but it’s only been 

there for a few seconds, everybody is probably 

still sleeping – it is 5am, after all. You go to bed, 

and wake up in the morning all excited because 

you just know you’ve hit the jackpot. You turn 

on your computer, go straight to the forums 

to check your thread, and there you have it: a 

grand total of absolutely no replies at all. It stays 

quiet all day, and the next day. You start getting 

nervous. Five days later someone replies, “Hey, 

nice work. Took me a few minutes to figure out 

what you meant but cool idea.” That’s it, that’s 

all you get for your hard, intense work! Can 

nobody see the brilliance? What went wrong…?

   

We’ve all been there, I guess (or at least I’ve 

been there plenty of times). You messed up 

the final composition: you didn’t place the 

camera right and it suggests the wrong thing 

for the wrong character. Instead of people 

being impressed by your dark, über giant with a 

glowing sword, they actually think it’s a cute little 

character with tiny dots on the ground scattered 

all around him. So what did go wrong? 

This is something I’ll try to shine a little light on 

in this tutorial about camera placement, framing 

and other things to keep in mind to convey the 

right things for your image.

Introduction
When I was first asked to write this tutorial I 

immediately agreed. What a great opportunity to 

write something about a part of image creation 

that I really like, and also a good exercise for 

me to structure the knowledge I have about 

this topic? So I sent the email back, saying I 

agreed with it and I would be more than happy 

to write something. Not too long after I wrote 

that email though, I thought and realized what it 
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actually meant: writing about camera positioning 

and framing. In a way, you can just talk about 

overlay tricks, positioning and what it does to the 

subject, but the basics – or the fundamentals 

– of those theories and tricks are basic rules of 

composition. 

Now, composition is a slightly different story. 

People study composition for years, and 

most artists never really completely figure 

composition out perfectly. It’s a fascinating topic 

as well as a frustrating one. It’s an important 

topic, but a difficult one. And most of all, it’s a 

humongous, ridiculously over-the-top big topic! 

I’ve only just started to explore the world of 

composition and definitely haven’t figured it out 

yet. So this tutorial has become a bit of both, 

I guess. I focus on a quite specific element of 

composition and try to give lots of examples and 

tricks on improving dynamic framing, but there 

is no escaping composition theory. So I’ve also 

included some of that in here, too. Of course it’s 

short, cut down to fit into the story and it’s not by 

far a complete view on composition or dynamic 

framing and camera position, but hopefully it will 

become a small guide for you into the wondrous 

world of it all!

Composition
So let’s kick off with a little bit about the 

fundamental background of the whole thing: 

Composition. When you say “composition”, most 

people will think about the placement of dark 

and light elements on a canvas or the Golden 

Rule of Thirds, etc., which of course is true. But 

there is much more to composition than that! 

Composition is basically how you arrange your 

scene for the viewer. This can be purely down to 

aesthetics, or to tell a story; it can be 2D or 3D; 

it can be the design of an outfit or a landscape – 

anything and everything is or can been seen as 

composition (yep, it’s that big).

The thing with composition is that you can learn 

everything there is to know about it from text 

books, completely understand it, and 

still not be able to do it. It takes 

years of experience to even get the basics; 

to truly understand them and be able to apply 

them. I have to cut the whole thing down a bit 

in order for me to finish this tutorial before I’m 

80, so for the sake of this article and to keep 

it to an acceptable size, I’m going to focus on 

story driven composition with a special focus 

on camera placement and framing for dynamic 

characters. That being said though, I would 

advise everyone to read up on composition 

separately to this tutorial (I actually should start 

re-reading a lot of things myself as I’m sure I’ve 

forgotten some of it already).

Official composition rules are a great way to 

learn how to place things, but most of all they 

are great analytical tools to help you see what 

you’ve done wrong – or right. But I do feel 

that these formal composition rules, in 

my opinion, should be considered as 

guidelines and not laws, for it is always 

about what you want to tell or show, and 

any or every rule should be bent or broken 

for that purpose.

Camera Placement
Now that we have established that 

the whole problem with camera 

placement and framing is 

composition, where does it leave 

us? In exactly same place as 

before, unfortunately! I have 

included the information though 

because I think it’s important 

for people to realize that 

most of these problems 

are compositional 

ones. But for 

the sake of 

our tutorial, I’ll 

be taking the 

opposite 

road 

to the solution: not from how you want to tell 

it, but from what you want to tell. First and 

foremost, you need to know what you want to 

tell. This is the most important thing in a story 

driven image, and a necessity in order to choose 

a correct camera angle and a frame. 

Story
What do you want to tell?
What is the main element of your story? The 

scared face of your beautiful night elf just 

seconds before it gets smashed in by the 

ridiculously big hammer of an orc? Maybe the 

extreme size of the orc compared to your cute 

little night elf? Is it the tiny pink rabbits that are 

trying to flee the site of danger before they get 

elf blood on their pretty fur? Or maybe it’s the 

army of frustrated worms who 

have had it with the constant 

ground shaking, jumping 

and running of the 

stupid orc, and 

have decided to 

take action by 
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mobilizing the entire worm family, arming 

themselves with advanced, high-tech nano 

weapons, and under the command of the most 

feared worm general in history they stride to 

battle to take down the orc? All this is one 

scene?! 

The question is: what story do you want to tell? 

For any one of those above, I would pick a 

different camera angle. If you don’t know exactly 

what you want to tell then go to a cafe, have a 

drink and try to figure it out. If you don’t figure it 

out before you start then there is a small chance 

it will work out, but there’s a much bigger 

chance you’ll get a grand total of absolutely no 

replies on the pro art forums and you won’t be 

on your fast track to internet fame!

Getting your story ready

Okay, so how exactly do you get your story 

ready? One way, as I said before, is to have a 

drink. Alcohol works for me (most of the time), 

but let’s assume you’re not a drinker and want 

to figure this out in a bit more of a structured 

and analytical way. So the first thing you should 

always do is choose your story. I can’t really 

help you with that one; it’s your choice if you 

want to display the elf being smashed by the 

hammer, or not. I would personally go for the 

worm family, of course – it’s so ridiculous that it 

should be fun!

The next question is: what elements do you 

have to display in the scene? Which things 

are fundamental to the story? I’m always in 

favor of showing as little as possible without 

compromising the story. First of all, it leaves 

much more for the viewer to 

interpret for themselves. 

Or, to put it in other 

words, more people are 

bound to like it since 

everybody fills in their 

own details. Some 

will applaud you 

for your funny 

image and nice 

rendering skills, whilst the next person will 

go down on his knees because of your 

amazing intellectual depth in the image 

(of course, in reality you have no idea it 

could even contain “intellectual depth”, 

but whatever, just play along!). 

Secondly, it usually makes the 

image a bit calmer, since there 

are fewer elements to distract the 

viewer. And last but certainly 

not least, it’s less work. It 

can save you up to hours 

(or days), which you 

can then spend playing 

videogames or making 

your next internet famous 

image.

Something I’ve 

learned from 

game design is a 

little thing called the 

“MSCW list” (Moscow-list – easier to remember, 

which is basically: Must contain; Should contain; 

Could possibly contain; Would be nice to 

have. This is a way of creating a hierarchy of 

importance. Now I can tell you that Could never 

happens. Pretty much the same thing goes for 

Would. We can use a similar tactic to organize 

the information we have. So let’s focus on Must 

and Should. Must in the image with the worms 

is of course the worms; in particular the worm 

general with the advanced, high-tech nano 

weapon. Secondly, since it’s an army of worms, 

we need more worms – at least enough to 

suggest an army.

So here is our Worm General (Fig.01).

We’re going to need the orc with a hammer as 

well. Preferably, we need to see the elf, but a 

suggestion of her could be enough. 

Keep it simple! 

Don’t try to solve all the stories and problems 

in one image. You’ll fail! Pick one thing that you 

want to tell, and leave the rest for a second, 

third of whatever image. If you put too much into 

one scene, the viewer will get lost and confused, 

and that’s the last thing you want with this kind 

of image.

People in general look at a webpage for about 

seven seconds. Seven! And that’s if it contains 

a lot of text, etc. If it’s just an image, usually 

surrounded by other images, it’s probably less. 

So let’s say four seconds, which is not a lot of 

time to get a story across. You can’t explain 

everything, so whatever you show must be 

obvious. No, is must be more than obvious! 

Make it so that even a mentally challenged 

monkey looking the other way could get it in four 

seconds, and you might have a slightly better 

chance of getting noticed. 

Emphasizing your story
Okay, great. You’ve got your story down. You 

know exactly what needs to be shown and what 

can be left out. Now it’s time to think about what 

elements you can add to increase the drama, 

movement, humor, or whatever you want to 

show in your image. This is a very important 
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step because it is basically where you try to 

move the camera around in your head to look 

for the perfect angle of the scene. There are 

some things to keep in mind though when you’re 

staring into oblivion, trying to figure out where to 

put the camera:

Some Basics 

Kick force perspective, low horizon: 

Increases the size of the character, adding a 

threatening effect; makes the user small and 

the subject big; great for your giant and dragon 

illustrations (Fig.02).

Eye level on main subject, horizon in the 

middle: Size of main interest is approx. the 

same size as the viewer (Fig.03).

Bird’s eye view on main subject, horizon at 

the top: Subject of interest is smaller and/or 

lower than viewer; subject is dominated or the 

“underdog” (Fig.04). 

These are the 3 most basic options. Of 

course, you can apply them in subtlety or 

exaggerate them however you want. You 

can use one of them, or combine them. It 

just comes down to the question: what 

works best for your purpose? 

There is always going to be 

much more that you can 

do and play with!

Additional 
Supporting Elements
Composition Disclaimer

Now the following section 

is a bit of a dilemma. I want to 

talk about supporting elements like 

foreground elements, the direction of 

lines, and the space around a subject 

to create certain sense of motion, but 

those elements will only work if your basic 

composition allows it. Yes, here we are 

again: composition. But to fully dive into 

the realm of composition is quite a task, and 

as mentioned before it would probably require 

10,100 magazine pages filled with information 

written by – not me. I am far from a formal 

composition master or teacher. So what to do?

I’m going to slap composition in the face by 

stuffing it into a few basic boxes for this tutorial’s 

sake. Now, don’t kill me over this, I also have 

to go outside sometimes and get some fresh 

air, as well as eat. Talking too much about this 

subject will strip me of any form of what (very, 

very, very little) social life I (pretend to) have. 

Ok, so let’s get back to it. In general there are 

two types of composition: Static and Dynamic.

Static Composition is where the overall balance 

of an image feels solid (I am sure there is 

a much better way of describing this in one 

sentence, I just can’t think how), and there is no 

obvious sign of motion. It often uses horizontal 

and vertical lines in a central orientated layout, 

using a triangular, round or square composition 

(this is really putting it into a small box!).
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Dynamic Composition is where the image 

suggests movement, almost like a frame capture 

from a movie. It often uses curved and diagonal 

lines in an off-center layout, and often shows an 

element that suggests that it’s going in a certain 

direction – your brain automatically finishes 

the movement. Now, if you want to know more 

about this, please don’t email me. Read a book 

or take some lessons. If you want to complain 

about my composition blasphemy, you have all 

the right to, I guess. 

Let’s focus on Dynamic Composition

So you have your important elements clear. You 

know that you want to show it either big or small, 

depending on the purpose of your story. Now 

how do we get this baby moving?

Well first of all: don’t put your focus point in the 

center; don’t put it in the horizontal center; and 

don’t put it in the vertical center (Fig.05). No 

center! 

Disclaimer: there is no absolute rule in a lot of 

compositional rules. And, of course, you could 

put it in the center and still make it look dynamic, 

but you have to know exactly what you’re doing 

(and I’m betting that the chance is really high 

that you’re not reading this tutorial if you do. 

Good, so you put it out of the center. Why does 

this work? Well it breaks the perfect balance 

of the whole composition, but also it suggests 

movement. To put it simply: balance = static; off 

balance = dynamic. If there is room in front of 

the character, for example, it suggests an area 

where the person can move to. If you show a 

large area behind the character it suggests the 

character is coming from that direction (putting a 

big empty space behind a character can also – 

depending on your context of course – suggest 

an element of danger) (Fig.06). 

Secondly, you want to have more than one 

focus point: let the eye of the viewer wander 

around the image; let the viewer explore the 

image; allow eyes to follow lines and areas of 

contrast – the more the eyes move the more 

dynamic the image seems. Don’t make 100 

focus points – that won’t work! That will just 

frustrate you and your viewer. Keep it simple. 

Just trust me for now. 

Lines

Diagonal lines work great for a dynamic 

composition! Why? Because your eye 

automatically follows lines, and lines have a 

direction (a line does not have to be an actual 

drawn line, it can also be a suggested line by 

light, dark, colored or other elements (Fig.07). 

A quick note on lines: I was always a big fan 

of flipping my image in Photoshop. It’s great 
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because it makes you look at your image from a 

new perspective. The old Masters used to hold 

their images or paintings upside-down in front of 

a mirror to check for mistakes. But lucky us, we 

have an option called “Flip”! I’ve always wanted 

to make sure an image works in either direction 

– flipped one way or the other. Later, when 

I was researching some things about visual 

storytelling, I came across some information that 

explained that a line curved upwards from left 

to right is perceived as going up (Fig.08). But if 

you flip it, it is perceived as going down (Fig.09).

So an image doesn’t have to work both ways, 

because you read the image completely 

differently either way. It’s got something to 

do with the reading direction. We are used to 

reading from left to right, which is why we also 

“read” an image from left to right. This has 

even more implications than just a line going 

up and down: things on the right side of the 

vision have a tendency to be perceived as more 

threatening (in general); things coming from the 

right side – let’s say a train, for example – are 

also perceived as going faster than when the 

train with the same speed is coming from the left 

side. These are small, unconscious things, and 

all really dependent upon context and so on. But 

they are fun to play around with!

Depth Placement

There is the option of putting the subject 

anywhere in the distance. So why should you 

choose one or the other? Well, the safest 

way is to put your main element in the middle 

ground, add some foreground and background 

elements, and you’re done. But this is boring 

and far too easy! 

Putting your character in the middle of anything 

destroys the potential movement it can have 

towards any direction. It makes it balanced. 

Putting your character in the foreground 

suggests importance of the background, and 

an involvement of the background with your 

character. 
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For example, an empty, dried-out plane or 

desert stretching towards the horizon is much 

more threatening if your character is in the 

foreground element (Fig.10). This way the plane 

becomes much bigger, and it suggests that your 

character has to cross it or at least has some 

business with the unpleasantly big and empty 

space. 

If you place your character half way along the 

plane, it also suggests isolation, but the plane 

becomes much less impressively big (Fig.11).

By putting your character in the background of 

the same plane suggests even more solitude, 

and hints at a traveled distance (Fig.12).

So to sum up, placement in depth can be 

considered in the same way as placement on 

the horizontal or vertical axes. 

Camera Rotation

The simplest way of creating a dynamic 

composition is to rotate the camera. All naturally 

static horizontal and vertical lines – the horizon, 

trees, etc. – become diagonals, and it suggests 

that the camera or viewer is participating in the 

scene in a more active way (Fig.13).

Overlay Elements

Suggestion works great for dynamic scenes! 

Showing a little will make the viewer finish the 

rest in his or her brain. If you have a character 

that looks scared at the camera, it works, and 

it makes people guess a bit about what is 

happening (Fig.14).

If you show exactly why he or she is sacred, it 

still works a bit, but it’s less exciting (Fig.15).
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If you place an extreme foreground element, 

like an arm, hand, leg (or whatever) over the 

camera, it suggests involvement with something 

more, and the viewer is right in the middle of it 

(Fig.16).

A great way to learn about these compositional 

tricks is to analyze movie shots – old black and 

white movies in particular, like Macbeth, Citizen 

Cane, etc. (they’re worth watching anyway, even 

if you’re not studying them). 

Foreshortening and leaving the frame

Another great trick to suggest more is to have a 

certain line or element leave the frame – a leg, 

for example. This draws the eye of the viewer 

in towards the place where you want it. But it 

also suggests a world outside of the frame. It 

makes the frame more like the current view 

of the onlooker and suggests the potential of 

something else happening. 

You have to be careful with this, though, 

because it can also make the eyes of a viewer 

leave the image if not treated right. Remember 

the direction of lines! If a line is followed by the 

eye and it goes towards the edge of the canvas, 

and there is nothing to stop it and pull it back in 

again, the eyes will leave the canvas. 

Particles, wind, dust and superhero capes

A great way to enhance the dynamic feeling 

of your scene is to add elements that we know 

move, like wind, dust, small particles, falling 

leaves, and so on. It’s a sure shot way to 

making it dynamic (or at least moving). If we go 

to the empty desert again, with nothing in there 

except a character, we can see that it’s quite 

a static, non-moving scene. Why? Because 

it’s a dry, empty plane – nothing is happening 

(Fig.17).

Now, if we would add some suggestion of really 

strong wind by adding some sand blowing up 

from a little ridge, and some particles all going 

in the same direction (we’ll go with right to left, 

because it’s perceived to be a faster movement 

in this direction) all of a sudden the whole static 

desert becomes a moving – and even more 

threatening – plane. You can feel the sand 

gushing past your face and through your legs; 

you know you have to move through it but 

you can see there’s nothing to find shelter in 

(Fig.18).
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 If you have a character with a nice cape, dress, 

or other fabric elements that will show wind, 

you should make use of it! If your character 

doesn’t have it: What’s wrong with you? Have 

you wrapped your character up in latex? It better 

not be a guy! Just give it something that moves. 

If you avoid it hanging straight down as though 

made out of lead, it instantly suggests wind and 

movement. Such an easy trick, and yet it always 

works (Fig.19).

Guidelines

Remember that all these are guidelines. It’s 

much more important to figure out what you 

want to say and think about how to do it, rather 

than follow standard rules. Get familiar with the 

tricks and get to know why they work. And what 

they exactly enhance, but don’t become a slave 

to them, or to any trick for that matter. Try to 

keep an open mind and keep thinking on what 

you could do to improve what you are doing. 

Framing

Okay so you figured out your story, you’ve 

established your primary and secondary 

elements. Now let’s look at the limitations or 

possibilities of your frame. 

Framing
Alright! Framing: the package in which you 

wrap up your little story! The borders for your 

brilliance; your own little frame of infinite 

possibilities; the edges that border your deep, 

intellectual thoughts; your own piece of ... Yeah, 

OK, I think you get it!

Framing is as versatile as the composition you 

put in it, and actually, it is an important part 

of the composition itself. The frame is the first 

thing you see; it’s the work area and it depicts a 

lot of the suggestion of the scene even before 

the image is shown. Do you want your viewer 

to have an endless visual journey from left to 

right over a magnificent widescreen landscape? 

Or do you want to show them a deep and 

interesting vertical image? What about leaving 

the traditional frames for what they are, and 

pushing the limits a bit? What does a round 

frame do? How about a squared frame with an 

element leaving it?
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Fixed Frame
Framing offers lots of possibilities – that’s if 

you have the freedom to pick a frame anyway. 

Often in the commercial world there are certain 

limitations to the frame you can use. If, for 

example, you have to create a cover illustration 

for a book then you’ll have to work within the 

limitations of the format. This can make things 

a lot harder. When you need to display a lot of 

information about a landscape, for example, 

and a very wide horizontal frame would be 

perfect but the book is standard vertical size 

… Well, this is where you want to have a 

good understanding of composition, but more 

importantly about the most important elements 

that you need to show in your image. It is in 

these kinds of illustrations that you often have to 

sacrifice important things; the trick is to sacrifice 

the least important one. 
Sketching, thumbnailing and having a camera 

floating around in your head looking for the best 

possible angle are vital techniques to employ in 

these kinds of illustrations. However these kinds 

of frames are boring, or they’re boring to talk 

about at least because they are set, fixed, and 

there is nothing you can do about it. You just 

have to find a way to make it work. 

Free Frame
So I want to dive a bit further into the world of 

free frames; the place where you have endless 

possibilities – choice all over! The question is of 

course: Is more choice better? Choice is great if 

you can choose (now that makes sense, doesn’t 

it?). Sometimes having no choice is great in 

the way that if forces you to think about a less 

than standard solution. It pushes you outside 

of your own little safe world where everything is 

great, beautiful and boring. It forces you to get 

frustrated and start thinking again. 

I find that people often choose a frame 

because, well, just because it’s always like that: 

landscape = wide; portrait = vertical. Of course it 

works; it always works. There is not necessarily 

something wrong with it, providing you know 

why you chose it. 

So here we are: we have all the freedom in 

the world to choose a frame for our dynamic 

composition. What are the options? Well, 

infinite actually, but that would make this tutorial 

extremely long (or extremely short if I just keep it 

at the word, “infinite”). So let’s break it down into 

a few forced boxes again (I like that: pushing 

things or people into boxes where they don’t 

quite fit, but with enough force, or at the right 

angle, they will awkwardly look like they do sort 

of do). 

Basic Frames

The non-special, what-you-see-all-day-long 

frames:

Horizontal: Your basic screen layout. 

Comfortable to look at, fits in the view of a 

person. It’s a solid balanced shape. It’s great 

for showing things that require some width, 

or for images that you plan for people to use 

as backgrounds. It’s often a good choice for 

something that you want to feel like it has some 

sense of space, or if the space around an object 

is important. If you don’t know what to choose, 

go for this one: easy, simple, straight forward 

(Fig.20).
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Vertical: Again, quite a basic layout (but then I 

have put them in the basic category, so it does 

make sense). It has a familiar shape which is 

great for showing things that are a bit higher 

than they are wide, such as people. This shape 

also often shows a bit more depth, since a 

many elements tend to be overlapping or have 

foreshortening going on to make them fit in the 

frame (Fig.21). Now, I also find this shape a 

bit more dynamic. I’m not 100% sure why, but 

it might be because it’s less grounded then a 

horizontal shape. Maybe it’s because your eyes 

often can’t fully see the whole image at once 

and they have to travel up and down, left to 

right? Or maybe I just like it? Not sure!

Squared: I really don’t know what to say 

about this one (Fig.22). It’s good for a CD 

cover, but that’s about it in my opinion. I use 

it sometimes, but that’s mainly because I crop 

the vertical or horizontal image because of a 

mess up somewhere and then it eventually ends 

up squared. Squared is boring; it’s too solid, 

too rigid, too … well, it’s just boring. Anyway, 

since this is not science I am not obligated by 

objective facts, I can be as subjective as I want 

to be. And I will be! I think squared sucks! It’s 

just not fun! And there you have it. I don’t think 

anyone will look me up after reading this and 

punch me in the face because he (or she – I 

prefer she) is a squared frame fundamentalist. 

I just love to tell the whole world something 

sucks. It’s just great! Somehow it’s more 

rewarding than saying you like something. No, 

you really, truly think something sucks and the 

whole world can know about it – awesome! Of 

course, my opinion on things tends to change, 

so there is a good possibility that in the next 

year or so I may become an absolute squared 

frame fundamentalist!

Anyway, enough off-topic nonsense! We 

are here for information so let’s move onto 

something a bit more interesting.

Extreme Frames

Extreme frames! This is basically the same as 

the basic frames, but exaggerated. Now there 

should be a note to the usage of extreme and 

unconventional frames: by using a choice of 

frame like this, you have got to have a reason. It 

will stand out if you don’t, just because it is such 

an unconventional frame choice. That means 

that people expect it to make sense. You have 

to explain your choice of frame to the viewers. 

Now, if you choose an extreme widescreen 

frame for example, and you put a character in 

there (vertically), that means that the space 

around the character is given significant 

importance. The placement of your character in 

such a frame requires much more thought than 

in a regular frame. It can work out brilliantly – 

only if you place it right and there is a reason to 

place it there.

Extreme Widescreen: This one is awesome for 

über epic landscapes, or to show off exactly how 

long your hero’s cape is (Fig.23).

Extreme Vertical: This is a great choice for 

things that are extremely long, or deep. It’s a 

good choice if you want to have a wide angle 

camera lens and you want to show how big, or 

deep something is. It’s also a good choice for a 

3-point perspective (Fig.24). 

Unconventional Frames

“Unconventional” is pretty much anything that 

hasn’t fit into the previous headings. I rarely use 

them. Why? Well, because I don’t often have 

a reason to use them. They also take a lot of 

pre-thought since all applications and paper 

are pretty much always bound to have four 

90-degree angles, making them any variation 

of a square. So, if you want to do something 

different, you have to plan it, and you have to 

have a good idea why something like that would 

be a good idea. And I’m not too good at that – I 

tend not to plan. 

http://www.2dartistmag.com


page 74www.2dartistmag.com Issue 047 November 2009

Part 5: Camera Placement, Framing, Fore-shortening & Distortion  Dynamic Characters
But then, saying that I don’t plan would 

completely discredit the previous text that I 

wrote before this. I do plan! I don’t really like it, 

but sometimes you just have to. But, if I have 

a choice – as it is with free choice of frame – I 

choose not to plan too far ahead. 

Still following me? Good. The thing is that there 

should be a reason for your choices. Are you 

in an online art competition and you want your 

space marine to stand out next to all the other 

squared space marine images? Well then, yes, 

go to the forum, press Print Screen, get the 

background color and “fake” the unconventional 

frame. Give your space marine his gun outside 

of the frame. Cool!  

Ok, so a few conventional variations on 

unconventional frames. When people use 

unconventional things to be “original” they tend 

to choose the most common of uncommon 

things. Please don’t use it for that; use it 

because it fits the image. If you want to be 

original like that then go out and paint a bicycle 

with pizzas. Otherwise, just make an original 

story and choose a frame that fits it.

Round: This is a bit like squared, don’t you 

think? It’s solid, but it’s better than squared. I 

wouldn’t use it though unless I have to. It’s good 

for an avatar/portrait, I guess, but I’m not sure 

what else I would do with it. An epic landscape 

doesn’t really work in this one (Fig.25). 

Outside the Box: This one is fun (if you can 

use it properly, that is)! It’s a great way to 

attract attention to your image. It’s very good for 

creating a sense of depth. Have your warlord 

step out of the image; it really works wonders if 

well applied. Be careful with it, though, because 

if you make a digital image, the image is always 

squared, so you actually have to select the 

background color in order to fake the effect. This 

makes it only good for that one specific forum. 

Of course, it’s a bit easier if you make a comic, 

since you know the background and it’s always 

the same (Fig.26). 

Fuzzy Edge: This one is quite interesting, too, 

and it’s great when combined with one of the 

above! Again, be careful because the image 

will only work with certain backgrounds (unless 

you make the background a specific color and 

you create a new frame in your big frame). It’s 

hard to say what it is specifically good for since 

it depends so much on the image. It can also be 

nice to combine this with a normal sharp edge to 

create a surrealistic effect (Fig.27). 

Creating the Final Image
So you’ve got your story ready and you’ve 

decided on your choice of frame. Now you just 

have to put it together and make an image. It’s 

that simple!

The main trick here is to know what you want to 

make. Try out different setups; tryout a vertical 

frame or a horizontal one. Try adding an Overlay 

layer to the foreground, or perhaps even a big, 

empty space in the background. Try, try, try; 

sketch, sketch, sketch. Never go for the first 

one.

I could go into detail here on how to make 

an image exactly and setup your whole 

composition, but that would be ridiculous. 

Just try it out for yourself and use some of the 

elements described previously. I don’t want to 

make a 1, 2, 3 step tutorial on how to create the 

“perfect” image. I don’t want to hand out a sheet 

with tricks. Just use this as a guide to help you 

understand composition, camera placement, 

framing and the dynamics of an image better. 

Sorry for all those who were expecting a super 

trick to the solution of life, the universe, and 

everything under it, including eternal internet 

fame! It’s not here; I’m not your man. If you want 

to know that, go and read the Hitchhikers guide 

to the Galaxy (the answer is 42, by the way). But 

I do hope you’ve enjoyed reading this as much 

as I have writing it … 

Not that I was drunk while writing this (well, at 

least not the whole time anyway).

David Smit
For more from this artist visit

http://www.davidsmit.com

or contact

david@davidsmit.com

http://www.2dartistmag.com
http://www.davidsmit.com
mailto:david@davidsmit.com
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Chapter 1 – July
Introducing Photoshop’s Workspace, Graphics Tablets, Screen 

Calibration, Color Profiles and the Brush Tool

Chapter 2 – August 
Canvas Settings, Scanning Drawings, Swatches, Colour Pickers,  

Colour Theory, Layers and Custom Brushes!  
 

Chapter 3 – September
Composition Rules, Sketching and Perspective, Understanding 

Light and Blocking-In. 
 

Chapter 4 – October
Colouring from Greyscale, Colours beyond Blocking-In, Blending  

Methods and Using Photos 
 

Chapter 5 – November
Quick Masks, Using the Wand Tool, Liquify Filter uses, Layer  

Masks – and Painting! 
Nearing the end in the fifth chapter we shall be looking at adding 
photo textures to a painting with the use of Custom Brushes, and 

we’ll learn about several tools such as Quick Masks, the Extracting 
Tool and the Wand Tool, what use the Liquify Filter has, and the 

greatness of Layer Masks. Of course, we’ll also be painting some 
more

 
Chapter 6 – December

The Final Part: Finishing Touches, Filters, the Unsharpen Mask  
and Saving your Work

This Workshop Series will look at, just as the title suggests, all the things that we need to know to get us started with 

Photoshop – mainly for painting, but also for other things such as matte painting and photo manipulation, which often 

use the same tools. We will be covering all the technical aspects of the programme, as well as some technical sides 

of painting that’ll help us starting to swing the virtual brush!

• Free Brushes

“We’ve learnt that photos can 
be useful, as they are in the 

last installment, but there is 
another way of working with 

them that I personally find 
more appealing...”

http://www.2dartistmag.com/tutorial_resources/issue_047_nov_2009/tutorial04/tutorial04_freebrushes.zip
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Chapter 5 - Photo 
Textures, Quick 
Masks, Using the 
Wand Tool, Liquify 
Filter uses, Layer 
Masks - and Painting!
Software Used: Photoshop

Introduction
We’ve done so much over the past few months 

that some of you may probably ask, “What more 

is there to learn?!” Sure, what we’ve covered 

is more than enough to get us by, but there is 

always more. Never, ever believe you’re done 

learning. The moment we stop learning and 

developing what we already know, we start to 

stagnate, and to stagnate in art means to … just 

disappear.

In this chapter, we’ll have a look at utilizing 

photos as custom brushes to add some cool 

realistic textures into a painting, and we’ll also 

be looking at some tools that help us isolate and 

extract elements from images, the Layer Masks, 

and the rather fun Liquify Filter.

So, let’s jump right back into the deep end and 

continue where we left off in the last chapter!

Fun with Photos and 
Filters
We’ve learnt that photos can be useful, as they 

are in the last installment, but there is another 

way of working with them that I personally find 

more appealing (maybe because I just can’t “do” 

photos in paintings and because I like to be able 

to change as much as I can about things I add): 

using photographic texture brushes.

Texture Brushes
They are brushes made from photos – and 

how to make your own brushes we covered in 

the second chapter of this workshop, so you 

shouldn’t have any problems making your own 

at this point, either from your own hand-drawn 

textures or photos, or from royalty free images 

you download from the internet (3DTotal has 

released a free texture and reference library 

filled with royalty free photos which is worth 

a look: http://freetextures.3dtotal.com). There 

are also websites out there that offer pre-made 

royalty free texture brushes, but the ones I‘ve 

encountered so far have left a lot to be desired. 

But hey, that doesn’t mean there aren’t any out 

there that you may like – I’m just very picky!

In this case, we need some marble, stone and 

rock texture to add a bit more realism, as well 

as texture to the cliffs and the archway. Of 

course, the textures can be handpainted onto 

the picture, but texture brushes make the job 

a lot easier and less time-consuming, and this 

technique is a widely used practice.

Here’s a photo I got from CGTextures.com 

(Fig.01). This one we’ll be using for the cliffs. 

I’ve turned it into several brushes (Fig.01a) 

ready to be used. Of course, one brush would 

be perfectly fine, but to get a less “patterned” 

texture, several brushes are best as they won’t 

form an obvious repeat in the texture.

So let’s add a new layer over the cliffs. This 

is very important as you will want to be able 

to adjust the textures to your liking, and this 

works best on a separate layer. For once, no 

brush settings are required – just don’t un-tick 

the Spacing. The texture has to remain upright, 

so no Angle Jitter for variation of texture needs 

to be applied, although a minimal jitter set 

manually might be beneficial. Do away with 

the Opacity Jitter as well – both manual and 

Pen Pressure – as we won’t be painting, but 

stamping. That’s right; just like with a normal 

stamp.

http://freetextures.3dtotal.com
http://www.CGTextures.com
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We start on one side of the picture – if it’s the 

side closest to the viewer, make sure the brush 

is nice and big, as the cliffs are bigger here. If 

it’s the side furthest away from us, make the 

brush small. Keeping the brush at one size 

throughout would give you a texture that 

doesn’t adhere to the perspective of the 

image. So manually change the size a 

few times the further you go along the cliff 

walls. Also, instead of one, you may want 

to add more layers as you go along, if you 

are really meticulous, so you can erase 

overlapping parts from the different rock 

faces. Layers are necessary here because 

it is almost impossible to not go over the 

edges of things in some places, and you 

will want to erase those bits without 

destroying other parts of the texture. 

Another thing is to rotate the brush 

here and there to get the angle you 

need to work with your perspective 

– especially when using brushes like 

these that have lines in them. This is 

very important! It’s OK if it’s not spot-

on, as the texture won’t be quite that 

obvious later on (Fig.02).

When we’re done, we merge the texture 

layers and set to erasing the bits that go 

over the cliff edges (Round Brush, Opacity to 

Pen Pressure, Size Jitter off), then make the 

Eraser brush really soft and also manually 

reduce the Opacity, as we’re about to tune 

down the texture the towards the horizon 

(Fig.03). Sometimes it helps to reduce the 

Opacity of the layer while erasing to better see 

where the edges are that you don’t want to go 

over with your Eraser.

We can now set the layer mode to Overlay 

or Soft Light, depending on what works best, 

and reduce the Opacity as needed, if needed. 

Sometimes you may need to Duplicate the layer 

to get a better result, or you may want to change 

the color of the texture in some parts (to do 

that, Lock Transparent Pixels and paint over the 

texture where you want – don‘t forget to Unlock 

Transparent Pixels afterwards) (Fig.04).

It looks quite promising already, and we’ll be 

doing some tweaking to it all later. 

Note: Just like with adding photos into 

paintings, it may be beneficial to apply the 

Median Filter to make it work better with your 

painting style. Not too much though, as you will 

want to be able to see the texture for what it is.

For now though we repeat the whole procedure 

for the other side (Fig.05), and then move onto 

the archway. This one I want to look a bit like 

marble. I’d already made some marble brushes 

from photos from CGTextures.com a while ago 

for another painting, so I’ll be reusing them here 
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could cut up the image again and use separate 

brushes to texture the ground, but it isn’t really 

needed here. We just add a new layer over 

the background, stamp the brush on it once, 

and then transform it in size and perspective 

to match the painting. We erase, as before, 

all those areas that stick out over the ground, 

set the layer to Soft Light or Overlay, apply the 

Median Filter, and there we have it (Fig.09).

Note: Merge layers that you are done working 

on to reduce the file size. Just bear in mind 

that layers which have been set to any other 

Mode than Normal cannot be merged on their 

own without losing the Mode setting they are 

in. Also, they cannot be merged with another 

semi-transparent layer, even if that layer is 

set to Normal. The results are never quite the 

same. Try it and you’ll see what I mean. Merging 

texture layers with objects such as the arch or 

the background works, so do it if you feel that 

Photoshop is lagging.

textured rock faces and archway. For this I won’t 

be looking at sand photos, but water images. 

Of course sand images work too, but something 

about this particular water image (Fig.08) – 

again from CGTextures.com – struck me as 

great for this use. This shows again that, if you 

want textures, you don’t need to look for specific 

images – anything can be used to texture 

virtually anything. Just use your imagination!

We make a brush again for this, as using 

the photo as is would be a bit too crass. This 

time, no modification is necessary, as I want 

the whole photo for my texture. Of course, we 

with a couple of stone textures thrown in for 

good measure (Fig.06).

It’s the same procedure as with the rock faces, 

so we’d better get to work. Again, remember 

the perspective, and this time also the fact that 

it‘s separate marble blocks, so the texture won’t 

extend from one block to the next. The final 

result is worth it (Fig.07).

With all the stone textures done we can have 

a look at the ground. It is sand, which doesn’t 

really need texturing all that much, but a little bit 

of texture would be nice to compliment the well-

http://www.2dartistmag.com
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So what’s next? Maybe you wish to add some 

detail or embellishment to the dress. How about 

some embroidery or brocade? Lace, maybe?

One way of adding any of the before-mentioned 

to fabric is to once again paint it by hand. This 

is a very time consuming process, and may not 

be to your liking. Another way of doing it is to 

draw a pattern on a separate document, and 

then convert it into a brush to be used in the 

same way as we’ve used the brushes before. 

You could also use photos of lace and such to 

convert into brushes. When making continuous 

brushes – such as for lace borders – make sure 

the pattern you are using can be “stitched”, 

meaning that the ends of the pattern match 

up. Then simply set your brush settings so 

the spacing of the brush is in keeping with the 

length of the lace segments (Fig.10). This is not 

necessary for a repeat pattern that uses a 

standalone image (Fig.10a).

In this case, let’s have a look at adding 

brocade all over the dress. There are two 

ways of doing this after adding a new layer. 

You can either set your brush to rotate 

manually and hope for the best (Fig.11), or 

you can stamp your brush once on the new 

layer and then keep duplicating the layer and 

transforming the pattern to your liking – it’s 

much more controlled this way. The procedure is 

the same as it was with the rock faces, only this 

time we are dealing with fabric folds. Where the 

fabric overlaps, make sure the pattern doesn’t 

spill from one side to the other. Erase those bits 

that do spill over, but don’t for now erase the 

bits that go over the outside edges of the dress 

(Fig.11a). Merge all the pattern layers. Now we 

are done with this, the fun begins!

The Liquify Filter
Right now the pattern is flat, looking as if 

projected onto the dress rather than being part 

of it. To make it look like it is part of it we need 

http://www.2dartistmag.com
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to make it curve and twist with the folds and 

flow of the dress. This can be easily done with 

the Liquify Filter – you can find it under Filter > 

Liquify.

This filter is almost a program all by itself, and 

you can do some seriously fun stuff with it. For 

now though, let’s just concentrate on the task 

at hand. As the painting is rather big, but we 

only want to liquefy a small portion of it, the 

best thing to do is to select the area we want to 

liquefy using the Marquee Tool. Make sure to 

get all parts of the pattern into your selection, 

and also that you have selected the layer 

the pattern is on. Now open the Liquify Filter 

(Fig.12).

You can see in Fig.12 what settings I’ve 

selected for this part. The Brush size depends 

on how big or small a part you need to liquefy, so change it when and if necessary. This brush 

is not quite like a paintbrush, and we won’t be 

doing any painting with it; we’ll be using it like 

we’d use our fingers to mould clay or push putty 

into window frames, with short strokes, pushing 

the pattern into or over the folds (Fig.12a). 

Sometimes it is a bit hard to see where you’re 

pushing your pattern, but that’s OK because you 

can repeat the Liquify process a few times until 

you’re happy with the result (Fig.12b).

And now you see the reason why it is important 

to leave the pattern spilling over the edges for 

this: because it can get pulled quite a bit, and if 

it were already erased you’d end up with gaps 

around the edges.

http://www.2dartistmag.com
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Note: The Liquify Filter can be used for all 

sorts of things, from molding fabric patterns to 

adjusting facial features on your character. And 

as said, you can do some really funky – and 

also creepy – stuff with it. The Forward Warp 

Tool we’ve been using here is probably the 

least psychedelic one. Try out the others – it’s 

especially funny on portrait photos! 

We can now erase the bits going over the 

edges and adjust the Opacity and mode of 

the pattern to our liking. We can of course 

also change the color by painting over it (Lock 

Transparent Pixels) and apply the Median Filter 

if necessary (Fig.13).

With all these textures done, we’re really 

close to finishing the painting. The rest is 

detailing, like adding shadows: the cliffs and 

archway are already casting shadows on 

the ground; the dress tendrils, however, are 

not. We should rectify that now. Make sure to 

keep the light source in mind, and how far the 

tendrils are off the ground (Fig.14). According 

to that, we paint the shadows on the ground 

– preferably on another layer so they can be 

modified more easily without destroying the 

ground texture (Fig.14a).

Right, that’s done then!

Photo 
Manipulation and 
Matte Painting
We will have to leave the painting for a while 

now, as I would like to go through some other 

things that have nothing much to do with this, 

mainly for those of you who want to try their 

hand at photo manipulation, or matte painting.

When looking at really well-done photo 

manipulations, you’ll sometimes wonder how 

they did it. And besides that, how did they 

manage to cut out all those small bits and 
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pieces that must have been from several 

different photos, and manage to make them 

work so well together? There’s no trace of 

the tell tale “cut and paste” halo (an obvious 

edge that is either too harsh or too soft around 

the individually cut and pasted items), and 

no difference in color either, which one would 

expect from objects coming from several 

different photos. 

Well, we’re about to find out. The techniques are 

surprisingly simple, though they do take their 

share of time to get perfectly right, even for a 

seasoned artist.

It may be interesting for some of you to know 

that I actually started with photo manipulation, 

back in 1998 with Photoshop 5, on a wee-

laptop with a shoddy mouse. It was all very 

rudimentary, but I think it paved the way for 

me to go into painting. Already having gotten 

to know many of the tools was really helpful. 

Anyway, let’s see what my brain can still call up 

from back then … using the tools of today.

So, here’s a photo that I took in Rome of the 

ruins of the Temple of Saturn at the Forum 

Romanum (Fig.15). We want the structure, but 

we don’t want the background. Now, once again, 

there are several ways of cutting an object (or 

person, for that matter) out of a photo. None of 

these will be quicker than others; it’s just a 

matter of preference.

We could duplicate the layer, clear the 

background, and then use the Eraser to 

erase everything but what we want to keep. This 

is probably the most widely-used method. The 

brush to use for this would be the default round 

brush, with Hardness set to something between 

90 and 100%, slightly softer for things such as 

feathers or hair.

The Quick Mask Tool 

Another way would be to use the Quick Mask 

Tool. The icon on the left is your normal 

mode, the one we’re in right now. Clicking the 

icon on the right enables the Quick Mask mode. 

When it is on, it will tell you so in the title bar of 

your image. By double-clicking the icon on the 

right we get a small window pop up (Fig.16). 

Here we can change the masking color, as well 

as decide if we want that color to indicate the 

masked areas or the selected areas (areas we 

want to keep). I tend to like the default settings, 

so let’s stick with them.

In essence, this tool is like a very controllable 

and versatile selection tool. It works with the 

Brush and Eraser in the same way we’d use the 

Brush and Eraser while painting. All the brush 

settings are functional, though I would advise 

to not set the Brush to Size Jitter or Opacity 

Jitter for the most part, as the Opacity Jitter 

can be deceiving in this case. It may look like 

you have covered an area you want to mask 

completely, but in fact you haven’t – it just isn’t 

visible enough. I personally prefer this over the 

previously mentioned erasing method because 

you aren’t erasing anything, you’re simply 

masking something off and can then choosing 

to copy or cut out whatever you’ve masked. The 

original picture remains unharmed.

So let’s try this:

Select a Brush with a size that works for your 

photo, and just start to cover the areas you want 

to keep or mask off, depending on your previous 

selection (Fig.17). I find it easier to first of all 

http://www.2dartistmag.com
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mask off the big areas before getting into the 

nitty-gritty. Take your time with this; you want 

it to be as precise as you can possibly get it 

(Fig.17a).

Once we’re done with masking everything, we 

click on the left Quick Mask icon again to get 

out of Quick Mask mode. Now our selection 

should be visible (Fig.17b). Now we can copy 

the selection, and paste it onto a new canvas, or 

into a picture we are working on (Fig.17c).

Most of the time it will need some post work, 

which could be anything from erasing parts 

that weren’t that well masked earlier, color 

correction, light and shadow correction, the 

softening of edges, and so on, to make it work 

with your picture. 

The Wand Tool 

Another way of cutting pieces out of a photo is 

using the Wand Tool. When selected, we 

get several options in our options bar 

(Fig.18). This tool works nicely for clean 

block colors, but is a lot trickier to use 

on photos and also doesn’t give an all 

too desirable result. It works by selecting 

pixels of the same color or color range, 

depending on the Tolerance. The default 

Tolerance of 32 is pretty good, but still not 

good enough for most things. 

To use the tool, just hover over your image 

and then click the image where you want to 

select something. If you want to select more, 

hover over the next part you want to select and 

right-click on it. A small menu pops up (Fig.18a) 

where you can choose to do several things, 

most of which are self-explanatory. It’s actually 

best if you try them all to see what they actually 

do, or don’t do. Some of them work when you 

right-click on an area that hasn’t been selected 

yet (like Add to Selection); others (like Grow, 

Subtract or Similar) on areas that have already 

been selected. Feather is something that lets 

you soften the edges of your selection, almost 

like a gradual selection (from transparent to 



page 87www.2dartistmag.com Issue 047 November 2009

Beginner’s Guide to Digital Painting Part 4

solid), and you can choose the radius of the 

feathering. You can also change the Tolerance 

in-between selecting different areas of a picture.

When you’re done selecting things you can copy 

or cut your selection (or Inverse your selection 

– Select > Inverse – before cutting or copying, 

depending on whether you’ve been selecting 

bits you don’t want to keep, or not), and paste it 

onto your picture.

The Extract Tool

And then there is yet another way of extracting 

something from a photo: with the Extract Filter. 

You can find it under Filter > Extract. Just like 

the Liquify Filter, this is a bit like a program in its 

own right (Fig.19).

To work with it, simply select the size of your 

Brush and choose if you want it to be smart 

highlighting or not, and then trace around the 

edges of the object you want to extract from the 

picture, making sure that they are covered 

(Fig.19a). Then select the Paint Bucket Tool 

and click on the inside of the highlighted 

area. If your whole picture goes blue, there’s 

a gap in the highlighted line – try to find it, 

fix it, and fill it again with the Paint Bucket Tool 

(Fig.19b). Once it is filled you can choose to 

preview your selection. If you are happy with 

it, hit the OK button and your selection will be 

extracted (Fig.19c). This may need some post 

work as well, and just because it looks like a 

faster method of extracting something, it isn’t, 

really. Precision and patience are still needed 

when using this.

Note: Something to bear in mind when working 

with photos is to use images that are similar in 

light and color. It is much easier then to make 

everything look “together”, and you can change 

the colors and lighting in the post-production 

stage.

Layer Masks

There is another tool that can be very useful 

for photo manipulation. Let’s assume you want 

to add glass into your picture – be that a glass 
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or just glass, like windows and the like. Glass 

is generally transparent, which means that 

whatever is behind it shows through it. The 

same goes for liquid, or a glass with liquid in it. 

Sounds tricky, right? – Not quite!

The best method (that I’ve found) is to use the 

Layer Mask for tasks like this. You can find this 

tool at the bottom of your layers palette, and it 

lets you control the level of transparency much 

more easily than, let’s say, the Eraser would. 

Essentially it’s a bit like those blackboard 

toys you can get everywhere that are filled 

with black goop that you can push around to 

reveal rainbow colors underneath! Or, if you’re 

from my generation, we used to do it with wax 

pastels – one layer of color, and then another 

layer of pure black on top. We’d use a 

scraper to get the black off and reveal 

the color, if we were good kids. (If we 

were bad kids, we’d use mum’s baking 

palette knife.) We can do the same thing 

in Photoshop with the Layer Masks. Of 

course, the Eraser would work as well to 

reveal something that is beneath another 

solid layer, but using the Layer Mask 

gives you more control, and it’s easier to 

revert and undo any mistakes.

So, let’s play:

Here is a canvas with some random color blobs 

on it (Fig.20). And here is a solid black layer that 

I added on top of the colors (Fig.20a). We click 

on the Layer Mask icon in the layers palette 

– make sure your solid color layer is selected 

when you do this.

You will notice that the little color squares in 

your tools palette are black and white now. This 

is because the Layer Masks work with black and 

white – and any shade of gray in-between – to 

give you the choice of making something as 

opaque or transparent as you like.

Select a Brush. You can adjust its settings to 

your liking and to what works best for the work 

at hand. We will be painting over the solid 

color layer to mask it. Using black to paint with 

essentially unmasks whatever is behind the 

layer; using white masks it. In other words, using 

black will make things behind the layer visible; 

white does the opposite. Using any shade of 

gray in-between achieves varying transparency 

of the mask, no matter what color the layer is 

you are using the mask on. Easy! Let’s try it 

(Fig.21).

When actually masking glass or transparent 

liquid, precision is again vital; take your time 

with it and the result is well worth it.

You can also delete the Layer Mask if you are 

not happy with it, or just don’t want to use it in 

the end. To do this, drag just the Layer Mask 

(Fig.21a) into the bin in your layers palette – it 

will ask you if you would like to “apply mask to 

layer before removing“, and if you don’t want to 

do that, click Discard. If you want do, click Apply, 

and what was the mask will be imprinted on the 

actual layer. You can also do this by going to 

Layer > Remove Layer Mask > Discard/Apply. 

By the way, you can still work on the layer itself 

under the mask if you select the layer itself. 

Right, I believe that is it for this chapter!

In Closing...
Next month we’ll be looking at the last 

installment of this series, and with it at the 

finishing touches to the painting we started. 

We’ll be covering some more textures, color 

and in-depth Levels adjustments, a few more 

filters, and ways to save your picture for 

internet use as well as print and other 

media uses.

Nykolai 
Aleksander
For more from this artist visit

http://www.admemento.com/

or contact

x@admemento.com

• Free Brushes
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http://www.admemento.com
mailto:x@admemento.com
http://www.2dartistmag.com/tutorial_resources/issue_047_nov_2009/tutorial04/tutorial04_freebrushes.zip
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ghost king”, “waffle canyon”, or “sloppy slayer”. 

So if you’re struggling for an idea, give it a shot! 

You’d be surprised at how many mouth-watering 

combinations you can come up with!

I had a lot of ideas floating around in my soupy 

head for this image; some fairly straightforward 

– bet you can guess what those would be – and 

some more obscure in concept. Eventually I 

decided on one that was somewhat in-between. 

I also wanted to keep it open so the viewers 

could add in their own interpretations as well. 

For some, it would represent the secluded 

state that can result in a poor and unchecked 

gaming habit; for others it would bring back fond 

memories of the time they stayed up all night 

finishing their favorite game. These thoughts 

ran through my head as the concept developed. 

I wanted the viewer to question the motives of 

the demons outside the window. Are they real? 

Are they simply part of the boy’s imagination? 

Has the game come to life? Or are they the lost 

players that the boy is soon to join? Once the 

concept had simmered a bit it was time to put it 

to paper!

Let’s lay down the first slice of our sure-to-

be-delicious sandwich: the sketch. This piece 

was done in a very short period of time, so 

the sketch is very simple. Normally I sketch 

everything out to make it easier for me later 

on, but the scene was simple and I had a clear 

vision of how I wanted it to look. In Fig.01 you 

can see the resulting simplicity. The perspective 

was also pretty straightforward, but in more 

complex setups the Pen Tool can be very 

helpful in setting up guidelines. 

Next up: the meat (or Tofurky, if you prefer). I 

threw in some values to see how I wanted the 

focus to present itself (Fig.02 – 03). I knew the 

boy would take the center stage, so I filled the 

Making of the twisted 
room
Software Used: Photoshop

Section Title
For this making of article I would like to take 

you through the steps I took when creating my 

image, “The Twisted Room”. It’s an older image, 

but it is a piece that I had a lot of fun creating 

and I’d like to share that process with you, from 

concept to completion. I will be talking about 

how the image came to be and what steps were 

taken to create the final piece. Hopefully you’ll 

be able to get something out of it that will aid 

you in your own artistic endeavors!  Now, for the 

sake of entertainment and the fact that I’m super 

hungry, I’m going to present this “making of” in 

the form of a sandwich! So first let’s set out the 

plate. 

The initial spark for this particular image 

began with the two words: twisted and room. 

Sometimes when you’re stuck and looking for an 

idea, mixing and matching random words can 

be a great solution to the problem. I no longer 

have the time or luxury of getting “stuck”, but 

when I did I had a lot of fun with random word 

pairings and phrases, such as “valley of the 

http://www.2dartistmag.com
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surrounding area behind where the boy was 

going to sit with darker values. I also wanted the 

window to be a point of interest, so I decided 

to keep it in a midrange value. Once I had the 

ground work in I could start adding in the details 

(Fig.04). Since the piece had to be completed in 

a short period of time, I kept with the grayscale 

for a bit longer so I could focus on one thing at 

a time and get as much in as I could. Generally 

I don’t spend this much time in the grayscale 

stage, and depending on the complexity of the 

colors involved later it can be a waste of time 

because you are most likely going to paint over 

it at some point anyway. In this case, however, 

I knew the colors could be solved fairly easily 

through various glazes and overlays. I also 

finalized the boy’s positioning in this stage, as 

he was far too small in the earlier sketch. 

Time for the toppings! As I mentioned 

previously, the colors were brought in through 

multiple Overlays. The palette is fairly simple, 

focusing mainly on the colors red and blue 

(Fig.05 – 06). I felt they could represent the 

theme quite well: the red could accentuate the 

dark and twisted elements, while the blue would 

set the stage for boy’s mental state. These 

colors also helped greatly in pulling him out from 

the background. 

http://www.2dartistmag.com


page 93www.2dartistmag.com Issue 047 November 2009

The Twisted Room Making Of

Now for the last slice of bread! I’m almost 

finished at this point, but there are a few things 

that need to be added and adjusted. The bottom 

right corner was feeling a bit heavy so I decided 

to flip the image. The reasoning behind this is 

that the bottom right corner is generally seen 

as the heaviest, so the quick fix to this was a 

flip. I also added in the last bits of detail, such 

as the phrase behind the computer, “Play for 

H…” (Fig.07). What does it say and what does 

it mean? And why is it backwards?! Is the room 

playing tricks on the boy or did the artist simply 

not notice when he flipped the image? It’s all 

part of the mystery! Stepping back I noticed that 

the corner under the window was a bit dead, 

so I added some lighting from the window to 

add direction for the viewers’ eyes. Otherwise 

they may get stuck there, and that’s not a good 

place to be stuck! Last but not least, I finished 

up the boy, giving him his creepy, spaced-out 

demeanor, and therefore completing the theme 

of the painting. 

Finally, it’s time to eat and digest! I hope 

you’ve enjoyed the making of my twisted 

room sandwich. I must say, it’s been a pretty 

tasty experience. Looking back there are a 

few ingredients that I would have added and 

changed, but as a whole I feel it still makes for 

an entertaining and fun painting to enjoy, so 

I hope you do! I’ve learned from it, and more 

importantly I had a great time doing it. Thanks 

for reading! 

http://www.2dartistmag.com
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